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Preface

This documentation describes how to test business services, subprograms, subroutines, and maps
in the NaturalONE environment. It is organized under the following headings:

Release Notes Information on new features and enhancements.

Overview of Test Functions Brief description of this NaturalONE component.

Using the Test Functions Information on how to use the test functions supplied with
NaturalONE.

Setting Preferences for Application Describes the preferences you can set for the test functions, such as
Testing setting preferences for logging unit test results and synchronizing local
resources with those on the server.

Creating Ant Scripts to Run Unit  Information on how to create xml-based Ant scripts to run unit test
Tests files (file extension .bsrvtst, .exttst, .nattst, and .seqtst), and then create
a Junit test file to run the Ant scripts programmatically from Java.
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Release Notes

These Release Notes pertain to the Application Testing component of NaturalONE version 8.2. The
following topics are covered:

What's New in Version 8.2.1
What's New in Version 8.2.2
What's New in Version 8.2.3
What’s New in Version 8.2.4
What's New in Version 8.2.5
What's New in Version 8.2.6
What's New in Version 8.2.7

What's New in Version 8.2.1

This section describes the new features for the test functions supplied with NaturalONE version
8.2.1. The following topics are covered:

= Natural Unit Tests
Natural Unit Tests

This section describes changes to the Natural unit test functionality. The following topics are
covered:

= |mproved Unit Test Functions

= Test an External Subroutine

= Support for Local Decimal Format
= New Log File and Report Functions

Improved Unit Test Functions

You can now create a unit test that will pass when an expected error occurs. You can also search
for a specified string in message text. For information, see Test for an Expected Error. In addition,
the following changes were made to the unit test functions:

® You can now use mathematical comparisons (for example >, <, =, <=, >=) in the Configure Field
Validation window.

* The available controls for the selected field are now displayed in the Configure Field Validation
window.

® The available controls for the selected field are now displayed in the Configure Input Field
window.

For information, see Create a Unit Test for a Business Service.
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Test an External Subroutine

You can use the test options to test an external subroutine using either a subprogram or a program.
For information, see Test an External Subroutine.

Support for Local Decimal Format
The tester now supports the decimal format for a local region. For example, a decimal number in

Germany can be "12343,99". To set Eclipse to another region, add the following code to the program
arguments window:

-nl de

where "de" indicates Germany.
New Log File and Report Functions

You can now create unit test log files and then use the log files to create summary reports. For in-
formation, see Create Summary Reports for Unit Test Log Files.

Fixes

This section describes the bug fixes in this release of the Application Testing component. The fol-
lowing topics are covered:

= Test Business Services in Projects that Reference the Construct Runtime Project
Test Business Services in Projects that Reference the Construct Runtime Project
When testing a business service in a project that contains generated objects that reference the

Construct runtime project, the runtime project was not searched and an error was displayed. This
problem has been fixed.

What's New in Version 8.2.2

This version contains several error corrections. New functionality is not provided.
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What's New in Version 8.2.3

This section describes the new features for the test functions supplied with NaturalONE version
8.2.3. The following topics are covered:

= Enhancements
Enhancements

This section describes the changes in this release of the Application Testing component. The fol-
lowing topics are covered:

= Ensure Code Synchronization with the Server While Testing Subprograms
= Create Unit Test Validations to Test for Mathematical Comparisons

Ensure Code Synchronization with the Server While Testing Subprograms

While testing a subprogram, a message may be displayed indicating that a local resource has not
been uploaded to the server and synchronized with the server resource. You can now use settings
in the Preferences window to decide how to handle this scenario. For information, see Set Server
Synchronization Preferences.

Create Unit Test Validations to Test for Mathematical Comparisons

You can now create unit test validations for Natural errors and data entry based on validator types
(i.e., not restricted to characters in the data type). For information, see Define Validations.

What's New in Version 8.2.4

This version contains several error corrections. New functionality is not provided.

What's New in Version 8.2.5

This section describes the new features for the test functions supplied with Natural ONE version
8.2.5. The following topics are covered:

= Changes to the Test Editors

= Access Testing Functions Through a New Folder Structure

= Eliminate Date/Time Information While Testing Subprograms
= Create a Unit Test that Accepts Input from an External File
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= Create Default Tests for Object-Browse-Subp and Object-Maint-Subp-generated Business Services
and Natural Subprograms

= Edit Settings Inline, Duplicate Values, and Add Multiple Entries to an Array Field in the Unit Test Editor
= Display the Elapsed Time a Test Takes to Run in the Natural Unit Test View

= Create a History Chart and Display Elapsed Time and User IDs for Unit Test Log File Reports

= Log and Save the Test History for an Ant testsuite Task

Changes to the Test Editors

All toolbar controls for the Test editors are now available in the editor toolbar. These controls were
previously located in the Eclipse toolbar.

Access Testing Functions Through a New Folder Structure

The folder structure used to store Natural and business service unit test files (file extension .nattst
and .bsrvtst) has changed to take advantage of new testing options. The new structure includes a
Testing-Suites folder within a Natural project. For example:

natural_project_name/Testing-Suites/optional_suite_subfolders/test_name.nattst (or <
.bsrvtst)

You can either use the Enable for Application Testing option on the context menu for a project
to add the Testing-Suites folder or you can create a new unit test and the folder will be automat-
ically added to the current project (along with any subfolders). The optional subfolder in the above
structure can also be created using the new Create Test Suite context menu option.

| Notes:
1. Any test files stored outside of the new folder structure will display a warning marker (a "!"
symbol on the Navigator file icon) and an entry in the Problems view indicating that they are
not in the proper place. You can continue to run these tests individually (i.e., selecting Run
Unit Test on the context menu), but you can only run more than one test from the Testing-
Suites folder.

2. Ant scripts for Natural unit tests can contain unit test files existing outside of the above folder
structure.

3. The Create Unit Test Report context menu option is only available from the Testing or Testing-
History nodes in the Navigator view (previously available from any Navigator node).

Application Testing )
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Eliminate Date/Time Information While Testing Subprograms

A new option in the testing editor allows you to blank out date and time information when testing
business services or subprograms. For information, see Define Date and Time Details.

Create a Unit Test that Accepts Input from an External File

A new wizard is available to create a unit test that accepts input and/or validations from a CSV
(comma separated values) file (file extension .csv). This type of unit test eliminates the need to
create many unit tests that contain similar data and it decreases the effort required to maintain
the test. For information, see Create an External Data Unit Test.

A new wizard is also available to record the test data used to test a business service or subprogram
directly and then export the data to a CSV file. For information, see Export Test Data to a CSV
File.

Create Default Tests for Object-Browse-Subp and Object-Maint-Subp-generated Business Services
and Natural Subprograms

Default unit tests can now be created for all object-browse subprograms generated using the Object-
Browse-Subp wizard and all object-maintenance subprograms generated using the Object-Maint-
Subp wizard (both Velocity and Construct-generated). The tests can then be customized as required.
For information, see Generate Default Unit Tests.

Default unit tests are generated for:

® Each browse key for an object-browse subprogram.

® Each function for an object-maintenance subprogram (such as GET, NEXT, etc.).
Edit Settings Inline, Duplicate Values, and Add Multiple Entries to an Array Field in the Unit Test Editor

The unit test editor has been enhanced to include new editing functions. For example, you can
now edit the Input and Validation settings inline instead of through the Edit button, or use the
Duplicate button to quickly copy values from one field to another. In addition, an Add Array
button was added to allow you to add multiple entries to an array field at the same time. For in-
formation, see Create a Unit Test for a Business Service or Subprogram.
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Display the Elapsed Time a Test Takes to Run in the Natural Unit Test View

The Natural Unit Test view now displays the length of time in seconds that a test takes to complete.
For information, see Run the Unit Test.

Create a History Chart and Display Elapsed Time and User IDs for Unit Test Log File Reports

A new History chart report is now available for unit test log files, which provides a graph of the
Pass/Fail count, and two new columns have been added to the Detail report: elapsed time and
user ID. For information, see Create Summary Reports for Unit Test Log Files.

Log and Save the Test History for an Ant testsuite Task

Two new options have been added to log and save test history for the Ant testsuite task to the
Testing-History folder. For information, see Define the testsuite Ant Task.

What's New in Version 8.2.6

This section describes the new features for the test functions supplied with NaturalONE version
8.2.6. The following topics are covered:

= Create a Sequence Unit Test
= Create Unit Tests and Data (CSV) Files from the External Data Unit Test Wizard

Create a Sequence Unit Test

A new wizard is available to create a unit test that executes a sequence of business service and/or
Natural unit tests. The generated test invokes target test business services/subprograms and can
copy data between each call. In addition, you can create new unit tests from the sequence unit test
editor. For information, see Create a Sequence Unit Test.

Create Unit Tests and Data (CSV) Files from the External Data Unit Test Wizard

You can now create a unit test and/or data file (file extension .csv) while generating an external
data unit test. In previous versions, these files had to exist before creating the external data test.
For information, see Create a New Unit Test and Create a New Data File.
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What's New in Version 8.2.7

This section describes the new features for the test functions supplied with NaturalONE version
8.2.7. The following topics are covered:

= Export/Import Test Data for Business Services and Subprograms
Export/import Test Data for Business Services and Subprograms
You can now export and import test data for a business service or subprogram in the test editor,

which makes it quicker and easier to run similar tests without manually re-entering the input data.
For information, see Export/Import Test Data.
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2 Overview of Test Functions

This section provides an overview of the test functions supplied with NaturalONE. These functions
are:

® Test a Business Service or Subprogram Directly

Provides an easy way to run a business service or subprogram by analyzing the parameters,
displaying them in a test editor (tester), and allowing you to change the input values. You can
then run the test and verify the return values.

® Create a Unit Test for a Business Service or Subprogram

Allows you to specify a business service or subprogram to test, supply input values, and then
provide validation criteria for the output of the call (for example, you can supply two numbers
as the input values and a value for the result field as the validation criteria).

J Note: You can create Ant scripts to run unit tests (file extension .bsrvtst, .exttst, .nattst,
and .seqtst). For information, see Creating Ant Scripts to Run Unit Tests.

B Create an External Data Unit Test

Generates a unit test that accepts input and validation values from a CSV file (file extension
.CSV).

® Create a Sequence Unit Test

Generates a unit test that executes a sequence of business service and/or Natural unit tests.

® Test an External Subroutine

Tests a subroutine using either a subprogram or a program that calls a subprogram.

® Test a Natural Map

Test a Natural map as you would on the server.




Overview of Test Functions

) Notes:

1. To install the Application Testing component, you must select Designer > NaturalONE > Ap-
plication Testing in the installation tree for the installer.

2. The tests are run using the EntireX RPC mechanism. While many details are hidden, you must
have some knowledge of EntireX RPC to run the tests.

3. As a business service cannot be tested in the local Natural runtime environment without a full
local installation of Natural Business Services, the tests are simulated locally by calling the
subprogram directly.

10 Application Testing
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Using the Test Functions

Note: To test subprograms and business services directly, and to create unit tests for subpro-

grams and business services, a Natural RPC server is required. The Natural Development
Server cannot be used in this context. If you are testing items in a project connected to the
local Natural runtime environment, a special connection via RPC must be made.

Features of the Test Editors

This section describes the features of the test editors, such as navigation options and toolbar icons.
The following example shows the Test Business Service editor, which is similar for both business
services and subprograms. The INPUT-DATA and OUTPUT-DATA fields have been expanded

for the example:

|Er) Caleulatar 3

Test Business Service

Data

Business service: DEMO, Calculakor

Method: Add w

Properky
#FUMCTION -=
#FIRST-NUM -= 0
#SECOMD-MUM -0
#5UCCESS-CRITERIA -= 0
= OUTPUT-DATA
#RESULT -=0
#TIME
#SUCCESS - = False

Drata | Conneckion

Walue

Keyboard navigation is supported in all editors. In the example above, you can use keys on the
keyboard to move from one field to another in the tree view and/or navigate to the table on the

right to add or edit values.

The following table describes each of the options available on the editor toolbar:

Toolbar Icon | Description

Run Test
% -
local Matural runtime
Matural RPC Server (2)
Matural RPC Server
® Natural RPC Mainframe
<Custom =

Q- Runs the current file using the values defined in the editor. Use the down arrow to display the
available environments in which to run the test and select a different environment. For example:

12
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Toolbar Icon

Description

Stops the current test.

Records the test data for export to a CSV file (file extension .csv), which can then be used as
input for an external data unit test. After selecting this option, either the record function for
the test will begin or the Define External Test Details panel will be displayed to define the
external data unit test. To change details about the recording, select the down arrow. For

% -

Configure Recording...
example:

The Define External Test Details panel is displayed. For more information, see Export Test
Data to a CSV File.

C.

Exports test data (field names and values) from the data tree in the test editor view to a new
or existing test data file (extension .tstdata) in the workspace. For information, see Export Test
Data.

I8

Imports an existing test data file in the workspace to the data tree in the test editor view by
matching field names in the imported test data file to field names in the editor tree. For
information, see Import Test Data.

Resets all data values and structures to their default values.

Test a Business Service or Subprogram Directly

This section describes how to test a business service or subprogram directly. The following topics
are covered:

= Test a Business Service Directly
= Test a Subprogram Directly

= Export/Import Test Data

= Export Test Data to a CSV File

Test a Business Service Directly

This section describes how to test a business service directly. The following topics are covered:

= Test the Service

= Define Date and Time Details

= Define Connections

= Define Additional RPC Environments
= Save as a Business Service Unit Test

| Note: The subprograms used for the service must be available locally. If they are not available

locally, download them from the server.
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Test the Service

» To test a business service directly:

1 Open the context menu for the business service in the Navigator view.

2 Select Testing.

The testing options for business services are displayed. For example:

T Mavigatar &3 =8
= -
=] <‘===€> ~E
+-[= settings
== Business-Services
E3 g _steplibs Hew »
[E;Mz . Open
oA Open With ’
Caloulakor, v

Calculaborfc 7= Copy
Cuskorner vl
CustomerCre
Cuskarneriyil
Customeriil Ve
ErrorMessag Rename...
FlipString. w1
e
2]
A% Expart. ..
Order.vl.l. ==
Order v2.1.| &' Refresh

Product,«1, ]
StringManip,  WaturalOME

Warehouse. B: Test Business Service

KarrayBaset Busmess Services
Generate Java Client...

¥ Delete

Irnpork, ..

Create Unit Test,.

Generate Web Service. ..
Code Generation L4

Validate

Run As
Debug As
Profile As
Team
Compare With
Replace with

- rF vy v wv v

-

MNATSElE
JPA Tools L4

Properties

3  Select Test Business Service.

The business service is displayed in the editor view. For example:
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| Caleulatar &2

Test Business Service

Data

Business service:  DEMO, Calculakor

Method: Add w

Property
+- QUTPUT-DATA,

[ata | Connection

Walue

| Note: For information on using this editor, see Features of the Test Editors.

4  Expand the INPUT-DATA and OUTPUT-DATA nodes.

The Data tab displays the properties and values defined for each parameter used in the test.

For example:

|z Caleulator 2

Test Business Service

Data

Business service:  DEMO, Caloulakor

Method: Add w

Property
HFUMCTION -=
#FIRST-MUM -=0
#SECOMD-MUM -= 0
#SUCCESS-CRITERIA -=0
= QUTPUT-DATA,
#RESULT -> 0
#TIME
#SUCCESS - false

Data | Connection

Value

5  Select each input and output field to use in the test and define the value for the Value property.

For example:

Application Testing

15



Using the Test Functions

Parameter Value

FIRST-NUM 2
SECOND-NUM (3
RESULT 5

SUCCESS true (select Value to change the value from false to true)

Optionally, you can:

Task Procedure

Define test data for another method used by the |Select the method in Method.

business service.
Note: Changing the method may change which

subprogram is tested; the parameters may also

change.

Define input parameters for the test. Expand the INPUT-DATA node and provide input
values for each property in Property and Value.

Define output parameters for the test. Expand the OUTPUT-DATA node and provide
output values for each property in Property and
Value.

Reset all data values and structures to their Select the Reset Data toolbar icon. For example:

default values.

Enter date and/or time details. See Define Date and Time Details.

Run the test in another environment. See Define Connections.

Interrupt a test that continues to run with no  |Select the Stop Test toolbar icon. For example: @
response.

Export and import test data for business services|See Export/Import Test Data.
and subprograms.

Record test data and then export it to a CSV file |See Export Test Data to a CSV File.
(file extension .csv).

6 Select % to start the test.
Define Date and Time Details
When defining the value for a date and/or time field in a subprogram used by a business service,

a window is displayed to enter details about the date or time. This section describes how to access
and define details about a date or time field.

» To define details about a date or time field:

1  Select Value for a date or time field in the testing editor.

For example:
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v Caloulator 53
Test Business Service

Data

Business service:  DEMO, Calculakor

Method: Add w

[= INPUT-DATA
FFUMCTION -=
FFIRST-MUM -2 0
FSECOMD-NUM -0
#SUCCESS-CRITERIA -= 0
[= QUTPUT-DATA
FRESULT -2 0
#TIME
#SUCCESS -3 false

Property Value
= Misc
DL FTIME (T}
Marme FTIME
= Value
Yalue

Drata | Conneckion

2 Selectl

J in the Value column.

The Enter Date/Time window is displayed. For example:

[CIBlank datetime
Fraction (1/10 second): I:l

I Ok H Cancel l

By default, the current date and time are displayed. Optionally, you can:

Task

Procedure

Blank out date and time information
when testing business services or
subprograms.

Select Blank date/time.

Change the date used for the test.

To change the month, select the up or down arrow for Date.

To change the day, select the day portion of Date and then
select the up or down arrow.

To change the year, select the year portion of Date and then
select the up or down arrow.

Application Testing
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Task Procedure

Change the time used for the test. To change the hour, select the up or down arrow for Time.

To change the minute, select the minute portion of Time and
then select the up or down arrow.

To change the second, select the second portion of Time and
then select the up or down arrow.

Use tenths of a second to define the |Enter the number of tenths of a second in Fraction.
time used for the test.

Define Connections

This section describes the Connection tab in the editor view. This tab is used to maintain inform-
ation about the environment in which the test will run.

» To define the connection settings:

1 Select the Connection tab for the test.

For example:

i) Calculator &3 =8
Connection @

Connection Settings

RPC environment: |Matural RPC Mainframe
Mote: To maintain values for this setting, see Preferences)SoftwarefG Entirex/RPC Environments.,
D Zusktom settings

Custom conneckion

Data | Connection

This tab shows the current connection settings for the RPC environment. For this example,
the settings define a Natural RPC Mainframe environment derived directly from NaturalONE,
as well as settings indicating how the RPC server will be started.

2 Select the environment in which to run the test in RPC environment.

This value defines the name of an EntireX RPC connection configured in Eclipse.

18 Application Testing



Using the Test Functions

i Note: The list of environments is defined in the Preferences window for RPC environ-

ments. For information on adding additional environments to the list, see Define Addi-
tional RPC Environments.

Or:

Select Custom settings and define the custom connection as follows:

Setting Description

Broker ID Broker identifier. Each installation of EntireX is assigned a Broker ID. This
number uniquely identifies EntireX to your network. If you do not know the
Broker ID, ask the network administrator for your organization.

Server Name of the Broker server used to logically describe a server (rather than the
name of the program that implements the server). This allows you to change
the program name without affecting the client programs that use the service.

User ID User identifier the server will use to assign the corresponding fields in the
EntireX control block when making calls using the EntireX ACI (Advanced
Communication Interface).

Password Password value the server will use to assign the corresponding fields in the
EntireX control block.

Natural logon required | Determines whether a Natural logon is required.

RPC user ID User identifier the EntireX RPC server will use to connect with the Natural
server.

RPC password Password value the EntireX RPC server will use to connect with the Natural
server.

3  Save the connection settings.
Define Additional RPC Environments

You can define additional RPC environments. Once new environments have been added, they
can be selected in RPC environment on the Connection tab.

» To define additional RPC environments:

1 Select Preferences on the Window menu. The Preferences window is displayed.
2 Expand the Software AG node.

3  Select EntireX > RPC Environments.

The RPC Environments settings are displayed. For example:

Application Testing 19



Using the Test Functions

- ;
= Preferences E]

[=- Software AG
Ajax Developer

Business Services

Code Generation

Construct

=)~ Entires
MET \Wrapper
C Wrapper
COBOL Wrapper
Cuskom Wrapper
DiCOM Wrapper
Deployment Environments
EJB \Wrapper
I0L Extractor for COBOL
I0L Extractor For Matural
I0L Extractor For PLJT
I0L Extractor For W3DL
Installation
Inkeqration Servers
Java Wrapper
Matural Wrapper
PL/I \Wrapper

‘Wb Service Wrapper
¥ML Mapping Editor
Matural

@

RPC Environments

Manage the RPC Environments For ¥MLISOAP RPC Server, Natural RPC Server and IDL Extractor Far PLJL

Table of defined RPC environments:

-

Mame
-5.N Matural RPC Mainfrarme
-5.'“ Matural RPC Server
-5.'“ Matural RPC Server (2)
T MLISOAP RPC Server
T RMLISOAP RPC Server (2)

Server Address
RPC/MESS3DEY/CALLNAT
RPCIMNESS3DEYCALLNAT
RPCIMATSRYZE00/CALLNAT
RPCISMLSERVER JCALLMNAT
RPC/SMLSERYERJCALLMNAT

K. Cancel

Select Insert.

The New RPC Environment panel is displayed.

Select Natural RPC Server in Type.

The specification fields for this type of server are displayed.

For example:

20
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Mew RPC Environmernt

Define a new RPC Environment,

7= RPC Environments |Z|®
im

LSRR ko &l RPC Server

Broker Parameters

Broker ID: *|

Server Address: *|

Timeout {Seconds): | a0

Entirex Authentication

Exbrackor Settings

P — T —

RPC Server Authentication

Library Mame: |

Program Mame: |

Wrapper Settings
(Cistaw () Save (3) Save local

1

Enwironment Name
(%) Default

() Other: |

Cancel

6  Provide the following details about the new environment:

Section

Description

Broker parameters

Type the broker ID, server address, and default timeout values in the fields

provided.

EntireX authentication

Type the user ID and password for EntireX in the fields provided.

RPC server authentication

Type the user ID and password for the RPC server in the fields provided.

Extractor settings

Type the name of the library and program from which to extract data in

the fields provided.

Wrapper settings

If the new environment is not a local environment, select Stow or Save
and provide the name of the library in which to stow or save wrapper

subprograms in Target library name.

Application Testing
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Section

Description

Environment name

After entering the Broker parameters, the default name of the new
environment is displayed in this section. If you do not want to use the
default name, select Other and provide a new name.

For more information about the settings on this panel, refer to the EntireX documentation.

7  Select Finish.

Save as a Business Service Unit Test

After defining the input and output parameters for the test, you can save it as a business service

unit test.

» To save the test as a business service unit test:

1 Select Save As on the File menu.

The Define Business Service Unit Test Details panel is displayed. For example:

7= New Business Service Unit Test

Define Business Service Unit Test Details

Enter the settings for a new business service unit test,

Target

Project: | NewProject

|[Br0wse...]

Parent suite: |

| {default) [Browse... ]

Test name: | Calculator

(... Testing-Suites/Calculator bsrvisk)

Display generated file(s)

Business service

Service File: | MewProject /Business-Services/DEMOYCalculator. w1, 1. 1bsry

|[Br0wse...]

Method: Add v

@j Finish

l [ Cancel

2  Provide details for the unit test.

For information, see Create a Unit Test for a Business Service.

B

Note: You can create Ant scripts to run unit tests (file extension .bsrvtst, .exttst, .nattst,

and .seqtst). For information, see Creating Ant Scripts to Run Unit Tests.

22
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Test a Subprogram Directly

This section describes how to test a subprogram directly. The following topics are covered:

= Access the Test Function
= Save as a Natural Unit Test

| Note: The subprogram must be available locally. If the subprogram is not available locally,

download it from the server.

Access the Test Function

» To access the function to test a subprogram directly:

1 Open the context menu for the subprogram in the Navigator view.
Or:
Open the context menu for the subprogram in the editor view.
Or:

Open the context menu for the subprogram in the Dependencies view.

2 Select Testing > Test Subprogram.

The subprogram is displayed in the editor view. For example:

jigm CALC 23 =5

Test Subprogram Gy - B | B e @

; Property Yalue
+- OUTPUT-DATA

Drata | Conneckion

This editor functions in the same way as the business service editor. The only difference
between this editor and the business service editor is that the business service editor has an
option to select the method (which can change which subprogram is tested internally).

| Note: For information on using this editor, see Features of the Test Editors and Test a

Business Service Directly.
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Save as a Natural Unit Test

After defining the input and output parameters for the test, you can save it as a Natural unit test.

» To save the test as a Natural unit test:

1 Select Save As on the File menu.

The Define Natural Unit Test Details panel is displayed. For example:

7= New Natural Unit Test |L,|'E|E|
Define Natural Unit Test Details g
Enter the settings for a new Matural unik tesk,
[ -
Target
Project: | MewProject | [Browse... ]

Parent suite: | | (default)
|

Test narme: | CALC
(.. JTesting-3uites/CALC . natkst)

Display generated File(s)

Makural

Subprogram: | MewProject/Matural-Libr aries TS 30EMO SR HCALC MM | [Brnwse... ]

@ Firish ] [ Zancel

2 Provide details for the unit test.
For information, see Create a Unit Test for a Subprogram.

| Note: You can create Ant scripts to run unit tests (file extension .bsrvtst, .exttst, .nattst,

and .seqtst). For information, see Creating Ant Scripts to Run Unit Tests.
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Export/Import Test Data

This section describes how to export and import test data for a business service and subprogram,
which allows you to populate the test data quickly without re-entering each field name. These
options are:

® Export test data (field names and values) from the test editor data tree to a new or existing test
data file (extension .tstdata) in the workspace.

] Note: The .tstdata files can be stored anywhere in the workspace.
® Import an existing test data file in the workspace to the test editor (matching field names in the
imported file to field names in the editor).
This section covers the following topics:

= Export Test Data
= |mport Test Data

Export Test Data

» To export test data to the workspace:

1 Open the context menu for the business service (or subprogram) in the Navigator view.

The testing options are displayed.

2 Select Test Business Service (or Test Subprogram).

The business service (or subprogram) is displayed in the editor view.

3  Select e on the editor toolbar.

The Define Details about the Test Data File window is displayed. For example:
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= Export Data |;|@@

Define Details about the Test Data File

Select a destination and enter a file name; existing files
will be owerwritten,

= Lvé MewProject-=daef.eur.ad.sag-7307 (6)

[= .settings

= .wsstack

= Business-3ervices

(= Construck

= Java
= b

(& Matural-Libraries
(== Testing-Histary

[= Testing-Suites
@. |User-Interface-Components

S calc-bus bstdata

File name: | cale-bus. kstdata |

(MewProject/calc-bus. tskdata)

[ [0] 9 l[ Cancel ]

4  Select the location in which to export the test data file.
The last exported .tstdata file is selected.

] Note: To overwrite data, select an existing file.

5 Type the name of the test data file in File name.

By default, the ".tstdata" extension is added to the file name.
6  Select OK to export the test data file.

If the test data file currently exists (as shown in the example above), an overwrite confirmation
dialog is displayed.

Example

The following example shows sample input for a business service test:
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i) Caleulatar 23 =0
Test Business Service Q- P - | B e @
Data

Business service: DEMO, Calculakor

Method: Add ~
= INPUT-DATA Froperty Walue
#FUMCTION - o Mist
#FIRST-NUM - 2 oL #SUCCESS (L)
#SECOMD-HUM - 3 Marme #SUCCESS
#SUCCESS-CRITERIA -2 0 - valus
= OUTPUT-DATA Yalue true

#RESULT -=> 5

Drata | Conneckion

After exporting the data, the following test data (.tstdata) file is created:

|Er) Caleulator |=| calc-bus.tstdata 3 =0

IINPUT—DATA HFIRIT-NUM=2
INFPUT-DATA. #3ECOHND-TUM=3
OUTPUT-DATL. $RESULT=5
OUTPUT-DATL. #3UCCESS=trus

You can modify this file using key=value pairs (for example, FIELDA=value). If the key begins
with a hash character (#), then the field name must be preceded by a \ character (for example,
\#FIELDB=value) or the field will be skipped. All other hash characters (such as CUSTOM-
ER.#NAME=value) do not require the \ character.

Tip: Using this file as an example, you can create test data files for all the functions, save

the files using appropriate names, and then change the values accordingly.

Import Test Data

» To import test data from the workspace:

1 Open the context menu for the business service (or subprogram) in the Navigator view.

The testing options are displayed.

2 Select Test Business Service (or Test Subprogram).

The business service (or subprogram) is displayed in the editor view.
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Select £21 on the editor toolbar.

The Import Data window is displayed. For example:

7= Import Data |;|@@

Select a test data file to import,

= ey oject->dacf eur ad sag-7307 (6) *

o4 l [ Zancel

Select the test data file to import (only projects/folders containing test data files are listed).
Select OK to import the file.

Any field in the imported test data file that does not have a matching field in the test editor
tree, or has a matching field containing an invalid value, will not be imported and will not
stop the import process. If this situation occurs, an Error log warning is displayed showing
problem fields.

Export Test Data to a CSV File

This section describes how to record the data used to test a business service or subprogram directly
and then export it to a CSV file (file extension .csv). You can then use this file as input to create an
external data unit test. For information, see Create an External Data Unit Test.

» To record the test data and export it to a CSV file:

1 Open the context menu for the business service (or subprogram) in the Navigator view.
The testing options are displayed.
2 Select Test Business Service (or Test Subprogram).
The business service (or subprogram) is displayed in the editor view.
3 Select % on the NaturalONE toolbar to begin recording.
The Define External Test Details panel is displayed. For example:
28 Application Testing



Using the Test Functions

7= Record Test Data

Define External Test Details

Enter details For the external (.csv) File,

Targek

Project: MewProject
Parent suite:

Jcsw file name:

File options
Delimiter: S

Sawe options: @.ﬁ.ppend (:) Owerwrite

@

- B

o

[N -]

bk

Zancel

Type the name of the external data file in .csv file name or select Browse to display a window

listing the available files for selection.

Optionally, you can use the Define External Test Details panel to:

Task

Procedure

Change the name of the project in which
to create the external data file.

Type the name of the Natural project in Project or select
Browse to display a window listing the existing projects for
selection.

Note: The project must currently exist.

Provide the name(s) of a subfolder(s) in
which to save the external data file. If the
folder does not currently exist, it will be
created for you.

Type the name of the folder in Parent suite or select Browse
to display a window listing the available folders for selection.

By default, the external data file is stored in the
Testing-Suites folder in the current project. If you specify
a suite folder name, it becomes a subfolder in the
Testing-Suites folder and the file will be stored in that folder.

Change the delimiter character used to
separate input values in the external data
file you are generating.

Type the character in Delimiter.

Replace test data in an existing CSV file
(file extension .csv) with new data.

Select "Overwrite" in Save options.

Note: If you specify the name of an existing file in .csv file

name and the Save options is "Append" (default), the test

Application Testing

29



Using the Test Functions

Task Procedure

data is appended to existing test data in the file. If the mode
is "Overwrite", existing test data in the file will be
overwritten.

5  Select Next.

The Select Data to Record panel is displayed. For example:

7= Record Test Data

Select Data to Record

Select and configure the fields and data to sawve.

Marne Input Qutput | Index
01 INPUT-DATA [l [l
01 QUTPUT-DATA = =

lExpand All ] [Collapse all

®

6  Select Expand All

The level 1 fields are expanded to display the lower level fields. For example:
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7= Recond Test Data |Z|®

Select Data to Record A
Select and configure the fields and data ko save,

[ ]

=

Mame nput Qutput | Index
= 01 INPUT-DATA

02 #FUNCTION (A30)

02 #FIRST-MUM (M5, 2)

02 #3SECOMD-MUM (NS, 2)

02 #3UCCESS-CRITERIA (MS)
= 01 QUTPUT-DATA

02 #RESULT (N11.2)

0z #TIME (T)

0z #5UCCESS (L)

OEEEEEEEO
OEEEEEEEO

Expand All l [Cnllapse all

@

] Note: To collapse the fields, select Collapse All.

7 Select Input and/or Output for each level 1 field you want to include in the recording.

Only the selected data for each field will be saved.
8 Provide index values in Index for any array fields.

9  Select Finish to begin recording.

The Recording icon changes to %= on the toolbar.

10 Define the test data in the editor view.

For example:
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[ Calculataor 53
Test Business Service

Data

Business service: DEMO.Calculator

Method: Add w

=) INPUT-DATA
#FUMCTION -
#FIRST-MUM -= 1
#SECOMD-MUM -= 2
#5UCCESS-CRITERIA - = 4
= OUTPUT-DATA
#RESULT -=> 4
#TIME

#3UCCESS - = False

Property

[= Misc
1oL
Mame

= value
Value

Value

#5UCCESS (L)
#5UCCESS

false

Data | Connection

| Note: For information on using this editor, see Features of the Test Editors and Test a

Business Service Directly.

11  Select % to run the test.

Repeat steps 10 and 11 for each test containing data you want to record.

12 Select %= to stop recording.

The generated CSV file is displayed in the Testing-Suites node in the Navigator view.

Create a Unit Test for a Business Service or Subprogram

This section describes how to create a Natural unit test for a business service or subprogram. The

following topics are covered:

= Enable for Application Testing

= Create a Unit Test for a Business Service

= Create a Unit Test for a Subprogram

= Generate Default Unit Tests

= Create a New Unit Test Suite

= Create Summary Reports for Unit Test Log Files
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= Use the Dependencies View
Enable for Application Testing

When you create a new unit test, the Natural project containing the test is automatically enabled
for application testing. This will create the Testing-Suites folder in the Navigator view and provide
warning markers on existing unit test files that are not in the Testing-Suites folder or its subfolders.
This section describes how to manually enable a Natural project for application testing.

» To enable a Natural project for application testing:

1  Open the context menu in the Navigator view for the Natural project containing the business
service or subprogram you want to test.

2 Select Testing > Enable for Application Testing.

For example:
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Create a Unit Test for a Business Service

TT. Navigakor 57

EBE 3ricurroject -

= .setings

[ Business-Services
(= Construck

= Java

= lib

(& Matural-Libraries

=daef.hg.sag

Tew
Go Inko
Open in Mew Window

) Copy

¥ Delete
Move. ..
Rename...

£2g Import...
£ Export...

& | Refresh
Close Project
Close Unrelated Projects

Extract IDL...
Generate Java Client...
Generate Web Service...

MaturalOME
Testing

Business Services
Code Generation

@- Enable for Ajax Developer

‘E Upload

Rebuild Project

Report
Validate

Run As
Debug As
Praofile As
Team
Compare With

Restore From Local History...

Web Services Stack

MATSkyle
Source
Configure

Properties

3
3
3

»

- v or v

ﬁ_: Enable For Application Testing

jigh Create Business Service Unit Test..,
g Create Makural Unit Test...
| Create External Data Unit Test...

jigh Create Sequence Unit Test..,

(g Create Test Suite. ..

The Testing-Suites folder is added to the project. All new unit tests will be generated into
this folder (or subfolder).

This section describes how to create a unit test for a business service. The following topics are

covered:

= Create the Unit Test
= Configure Input Parameters
Define Validations

Run the Unit Test

Open a Previous Unit Test
Run a Unit Test in Another Environment
= Test for an Expected Error
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= Test an Array Field

Create the Unit Test

» To create a unit test for a business service:

1 Open the context menu for the Natural project containing the business service in the Navig-
ator view.

Or:

Open the context menu for the business service in the Navigator view.

2 Select Testing.

The test options for business services are displayed. For example:
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3

T Mavigatar 3 =8

= .settings
[=1-[= Business-Services
= _steplibs

Mew
=& [EiEIMj . Cpen
bl Open With

Calculataorac 2 Copy
Customer,v]
CustameriCre
Customertdil
CuskornerAil Move. .
ErrorMessag Rename...
= R —
GreatestCon
Order vl 1,
Order.v2.1.| &' Refrash

Product, w1,

Skringranipy MaturalOME
Warehause, E5ting

warravBasel Business Services
Generate Java Client...

3 Delete

7 Export. ..

Generate Web Service. ..
Zode Generation

Walidate

Run As
Debug As
Profile As
Tearn
Compate With
Replace With

MATSEve
JP& Tools

Properties

Select Create Unit Test.

»

L |Eé‘) Test Business Service

»

* rF v v v v

-

Create Unit Test..,

The Define Business Service Unit Test Details panel is displayed. For example:
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= New Business Service Unit Test

Define Business Service Unit Test Details

Enter the settings For a new business service unit test,

Target

Project: NewProject
Parent suite;

Test name: | Calculator

(... Testing-Suites/Calculator bsrvtsk)
Display generated file(s)

Business service

Method: Add L

Service File: | MewProject/Business-Services/DEMO/Calculator . wi, 1.1, bsry

- B

5

[ -

{default)

Browse. ..

Finiish ] [ Cancel

Using this panel, you can:

Task

Procedure

Change the name of the project in which to
create the unit test.

Type the name of the Natural project in Project or select
Browse to display a window listing the existing projects
for selection.

Note: The project must currently exist.

Provide the name(s) of a subfolder(s) in
which to save the unit test. If the folder
does not currently exist, it will be created
for you.

Type the name of the folder in Parent suite or select
Browse to display a window listing the available folders
for selection.

By default, the unit test is stored in the Testing-Suites
folder in the current project. If you specify a suite folder
name, it becomes a subfolder in the Testing-Suites folder
and the unit test will be stored in that folder.

Change the default name for the unit test.

Type a new name in Test name. File names are saved with
the .bsrvtst extension.

Generate default unit tests for
object-maintenance functions and/or
object-browse keys defined for business
service subprograms.

Select Generate default Construct tests. This option is
enabled when the unit test will be created for a business
service that uses Velocity or Construct-generated
object-browse or object-maintenance subprograms. For
information, see Generate Default Unit Tests.

Not display the generated files in the editor
view after generation.

Deselect Display generated file(s).

Change the location of the folder containing
the business service file.

Type or select a new folder in Service file.
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Task

Procedure

Select a different method to test.

Select the method in Method.

Select Finish.

The unit test is displayed in the Testing-Suites folder in the Navigator view. For example:

T Wavigator £

== Business-Services
= _steplibs
== DEMD
.. domain
L@ Calculator.wl.1.1.bsry

L@ Calculatorddvance.w1.1.1,bsry

L@ Custamer.w1.1.1.bsry

L@ CustorerCreditAnalysis.v1.1.1.bsry

L@ Customer'withContactData, 1,1, 1 bsry
L@ CustomneriwithContactDaka, w2, 1.1, bsry

L@ ErrorMessageTesting. v1.1,1 bsry

L FlipString.w1.1.1.bsry

L@ GreatestCommonDenominator.»1,1.1.bsry

L@ Order.vl.1.1.bary
L@ Order.wZ.1.1.bsry
LD Product.v1.1.1.bsre

L@ StringManipulation.»1.1.1.bsry

L0 warehouse.v1.1.1.bsry

[37) #arrayBaseballPlayers.v1.1.1.bsrv

+-[E& Matural-Libraries
== Testing-Suites
=] —alculabor
.natural
X| .project

The test is also displayed in the editor view. For example:
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J

jiam Caleulator.bsrvkst &3 =0
Summary Q. @
w Matural
Project: MewProject

Business service: DEMO, Calculakor.w1.1.1
Method: Add

 Connection

Broker ID: localhost: 1971
Server: RPCIMATSAYZE00MCALLMNAT
* Input

 Yalidation

* Error

|:| Expect errar
Error class:
Error code:

Messaqe: D Regex

Summary | Conneckion | Input | Yalidation

The Summary tab displays information about the test, such as the name of the project, business
service, and method. It also displays the default connection settings. To define another con-
nection in which to run the test, see Define Connections.

| Note: You can use this tab to define an expected error, which allows a test to pass

whenever the expected error occurs. You can also use the tab to search for specified
text in an error message. For information, see Test for an Expected Error.

Select the Input tab and define which input parameters are sent to the server.

For information, see Configure Input Parameters.

Select the Validation tab and define which values must be returned for a successful test.
For information, see Define Validations.

Note: You can create Ant scripts to run business service unit tests (file extension .bsrvtst).
For information, see Creating Ant Scripts to Run Unit Tests.
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Configure Input Parameters

» To configure the input parameters sent to the server:

1  Select the Input tab in the unit test editor.
For example:
s MCUSTR_GET_1 nattst 53 =0
Input Gy @
Configure the input fields bo be sent ko the server,
Field Narne Index | Walue
CUSTOMER., CUSTOMER-MUMBER, 11111
CDADETZ, #FUMCTION GET
Summary | Connection | Input | walidation
2 Select Add.
The Configure Input Field window is displayed. For example:
’ Configure Input Field sy
Field narme: | [MPUIT-DATA, #FUNCTION A |
Inides: | |
Yalue
|
[ol4 l l Cancel ]
The list of available controls in Field name is based on the data type of the input field. If you
selected a logical field, for example, two option buttons are displayed to select "true" or "false".
If the field is an array, you can type the index for the array in Index.
3  Select the name of the input field in Field name.
4  Type the field value in Value.
5  Select OK.
The new field is added to the list of fields on the Input tab.
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Optionally, you can use the Input tab to:

Task Procedure

Edit an input field. See Edit an Input Field.

Remove one or more input fields.  |Select one or more input fields in Field Name using standard
selection techniques and select Delete. The field(s) is removed
from the list of fields and will not be sent to the server.

Duplicate an input field. See Duplicate an Input Field.

Add multiple elements to an array |See Add Multiple Elements for an Array Field. This option is
field. enabled when the PDA contains array fields.

Edit an Input Field

» To edit an input field:

1 Select the input field in Field Name on the Input tab.
2 Select Edit.

The Configure Input Field window is displayed to edit the field information.
3 Select OK to save the changes.

Or:

Select the input field in Field Name and edit the Value and/or Index values within the table.

Duplicate an Input Field

» To duplicate an input field:

1  Select the input field in Field Name on the Input tab.
2 Select Duplicate.

The Configure Input Field window is displayed to edit the field information.
3 Select OK to save the duplicate field.
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Add Multiple Elements for an Array Field

This section describes how to define a range of values for an array field.

| Note: The Add Array option does not support byte array and date/time fields.

» To add multiple elements to an array field at the same time:

1  Select Add Array.

The Define Array Element Details window is displayed. For example:

. add Array Elements |;||E| fg|

Define Array Element Details

Enter elements of the array, one entry per line,

DN /D). 1/ AREHOUSE-PROVINCE (AZD)

Walue{s)

®

2 Type each element of the array in Value(s), one entry per line.

3 Select OK to save the array field.

Define Validations

This section describes how to create unit test validations for Natural errors and data entry based

on validator types (i.e., not restricted to characters in the data type).

» To define validations:

1  Select the Validation tab in the business service unit test editor.

For example:
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jim MCUSTM_GET_1.nattst 53

Validation

Zonfigure fields to be tested after the call to the server is made,

Field Marme

Index

Walue

‘alidator

MSGE-INFO. ##M5G
M3G-INFO. # #RETURN-CODE

Comparisoniali,..

Stringwalidator

=0
&EO®

Add Array, .

Summary | Conneckion | Input | Yalidation

2 Select Add.

The Configure Field Validation window is displayed. For example:

'P Configure Field Yalidation

Field name: | INPUT-DATA, #FUNCTION

Inde:x: |

‘alidator: |String'u'alidatnr

Yalue

Walue: |

OF

] [ Cancel

l

The list of available controls in Field name is based on the data type of the input field. If you
select a logical field, for example, two option buttons are displayed to select "true" or "false".

If the field is an array, you can type the index for the array in Index.

3 Select the name of the input field in Field name.

4  Select the type of validator to use for the input field in Validator.

The type of validator to use depends on the type of data in the field. The available validators

are:

BooleanValidator

ByteValidator

® ComparisonValidator (displays a combo box with the options: ">", "

DateValidator

<v| n_n lv<=n H>=ll)

7 7 7

Application Testing
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* DecimalValidator

* IntegerValidator

" RegexValidator (creates regular expressions to validate the contents of a field)
= StringValidator

® TimeValidator

5  Select OK.
The new field is added to the list of fields on the Validation tab.

Optionally, you can use the Validation tab to:

Task Procedure

Edit a field validation. See Edit a Field Validation.

Remove one or more field validations. |Select one or more fields in Field Name using standard
selection techniques and select Delete. The field validation(s)
is removed.

Duplicate a field validation. See Duplicate a Field Validation.

Add multiple validations for an array |See Add Multiple Validations for an Array Field. This option
field. is enabled when the PDA contains array fields.

Edit a Field Validation

» To edit a field validation:

1  Select the field in Field Name on the Validation tab.
2  Select Edit.

The Configure Field Validation window is displayed to edit the field information.
3 Select OK to save the changes.

Or:

Select the input field in Field Name and edit the Value and/or Index values within the table.
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Duplicate a Field Validation

» To duplicate a field validation:

1  Select the input field in Field Name on the Input tab.
2 Select Duplicate.

The Configure Field Validation window is displayed to edit the information.
3 Select OK to save the duplicate field validation.

Add Multiple Validations for an Array Field

This section describes how to define validations for an array field.

| Note: The Add Array option does not support byte array and date/time fields.

» To add multiple validations to an array field:

1  Select Add Array.

The Define Array Element Details window is displayed. For example:

. add Array Elements

Define Array Element Details

Enter elements of the arraw, one entry per line,

Figld name: | AWHD . WAREHOUSE-PROYIMCE (AZ0)

Validator: | Stringvalidator “ |

Yalue(s)

®

2 Type each element of the array in Value(s), one entry per line.

3 Select OK to save the array field.

Application Testing
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Run the Unit Test

This section describes how to run one or more unit tests. It includes information about the Natural
Unit Test window.

] Note: You can create Ant scripts to run unit tests (file extension .bsrvtst, .exttst, .nattst, and

.seqtst). For information, see Creating Ant Scripts to Run Unit Tests.

» To run one or more unit tests:

1 Open the context menu for one of the following items in the Navigator view.

" A project containing the Testing-Suites folder.
® The Testing-Suites folder or a subfolder within the folder.

® One or more unit test files (file extension .nattst or .bsrvtst), regardless of where they exist.
Use standard selection techniques to open the unit test(s). Any test files stored outside of
the Testing-Suites folder display a warning marker in the Navigator view and an entry in
the Problems view indicating that they are not in the proper place.

2 Select Testing > Run Unit Test(s).

| Note: You can also use the context menu to change the environment in which a test is

run. For information, see Run a Unit Test in Another Environment.

The selected tests are displayed in the editor view and the results of the test are displayed in
the Natural Unit Test view. For example:

E Properties | [gy Matural Unit Test 53 % (E] &:_ﬂﬂ B-—H
Tesks Summary
B} o C.nattst (0, 4845) Test:CALC nattst

RPC connection: Matural RPC Mainframe (Broker ID: IBMZ HG, SAG:4010)
State: passed
Elapsed time: 0.434s

|§% Calculator, bsrvtst (0.512s)

| Note: If the test did not pass, a red circle (&) is displayed on the test icon in the Tests
section and State: failed is displayed in the Summary section.

The following table describes each of the options available on the toolbar for the Natural Unit
Test view:
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Toolbar Icon | Description

Q, Runs the current unit test using the values defined in the editor view.

Tip: You can also select % in the editor view to run the test.

i Selects the current unit test in the editor view.

= Opens the business service or Natural subprogram used for the current unit test in the
editor view.

&- Displays the test history for the last 10 unit tests that were run during the current Eclipse
session and allows you to select a previous test and load it into the editor. For information,
see Open a Previous Unit Test.

The Tests section in the Natural Unit Test view displays the name of each unit tests that have
been run. You can use the context menu for a unit test in the Tests section to select more op-
tions. For example:

= Properties EE Matural Urit Test &2 % RB gﬂ:_ﬂﬂ L'=|B -—0
Tests Summary
|E£.'J Calculabor . bisrvksk (0, Sk Tactu“aleulabor hepybst
q, Run... Matural RPC Mainframe (Broker ID: IBM2.HD.SAG:4010)
iz Open unit test Calculator bsrtst Fas

gﬂ:_iaﬁ Open Calculator.v1,1.1 . bsry

< >
Using this menu, you can:
Task Procedure
Run the unit test. Select Run.

Open the unit test file in the editor | Select Open unit test UnitTestName. The following file types are
view. available for selection:

" business service (file extension .bsrvtst)

" external data (file extension .exttst)

® Natural unit test (file extension .nattst)

= sequence (file extension .seqtst)

Open the associated business Select Open BusinessServiceName.bsrv or Open
service or Natural subprogram file | NaturalSubprogramName.NSN. The following file types are
in the editor view. available for selection:

® business service (file extension .bsrv)

® external data (file extension .NSN)

Note: This option is not available for external data or sequence unit

tests.
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The Summary section in the Natural Unit Test view displays:

Name of the test

Name of the RPC connection

Whether the test passed or failed

Length of time in seconds that the unit test executed before completing

To see the results of another test, select the test in the Tests section and the results are displayed
in the Summary section. For example:

] Properties | U Makural Unit Test 52 B RO
Tests Surnmary

[ CALC.nattst (0,375
(7]

)

Test:Calculabor, bsrvbst

RPC connection: Matural RPC Mainframe (Broker 1D IBMZ,HOQ.SAG:4010)
State: passed

Elapsed time: 2.062s

Calculator.bsrvt

Open a Previous Unit Test

» To open a previous unit test:

1 Select @~ on the toolbar in the Natural Unit Test view.

A list of the last 10 tests run during the current Eclipse session is displayed with a message
indicating the success of each test. For example:

B Propetties 'ﬂa Natural Unit Test 23 % ﬁa L'=|B - =08
Tests Surmmarsy |§3J Calc. exttst {passed)
£ Test: Calc,exttst [£5) Cale. exttst (Failed)
State: passed [ MCUSTN_NEXT nattst (passed)

Elapsed time: 1.125s
|§£fj MCUSTM_STORE. nattst {passed)

|§% MCUSTM_EXISTS. nattst. .. {passed)

|53J Customer_GET_1.bsrvtst (Failed)

|§£fj Calculator bsrvtst {passed) >
|§3J Customer_ExISTS.bsrvtst, .. (Failed)

|§% CALC natkst,,, (passed)

|§£fj MCUSTM_EXISTS. nattst. .. (passed)

In this example, seven tests passed and three tests failed.

2 Select the test you want to open.

The test is displayed in the Natural Unit Test view. For example:
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] Properties | [ Matural Unit Test &3 i@ BT~ O
Tests Surnrnaryy

|g'::fj Test: Calculator bsrvtsk
RPC connection: Matural RPC Mainframe (Broker ID: IBMZ2 . HQ. SAG:4010)
State: passed
Elapsed time: 0.578s

Calculator, bsrvtst (0

3 Open the context menu for the test.

4 Select the unit test file in Open unit test UnitTestName.nnntst.
The following unit test file types are available:

" business service (file extension .bsrvtst)
" external data (file extension .exttst)
® Natural unit test (file extension .nattst)

" sequence (file extension .seqtst)

Run a Unit Test in Another Environment

You can run any unit test in another environment.

» To run a unit test in another environment:

1 Open the context menu for one of the following items in the Navigator view.

" A project containing the Testing-Suites folder.
® The Testing-Suites folder or a subfolder within the folder.

® One or more unit test files (file extension .bsrvtst, .exttst, .nattst, and .seqtst), regardless of
where they exist.

2 Select Testing > Run Unit Test(s) using Environment.

For example:
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T Mavigator £2 =0
= <}==D =
= Ié MNewProject->daef .hg,5ag-7307 (1)
(= .settings
(& Matural-Libraries
== Testing-Suites
Ham ACUSTM_L Mew 4
N ACUSTN NG Open
5] Open With 4
1gm Calculatar,
N Warehousg (= Copy
W= .natural
W=l oproject ¥ Delete

Mave...

Rename...

=g Import. .,
£ Expott...

& | Refresh

MaturalOME 4
Code Generation ¥ (5]

Run Unit T R ek = N |ocal Matural runtime

Matural RPC Server (2)

Naa Create Business Service Unit Test... Matural RPC Server
ik Create Matural Unit Test. ., Matural RPC Mainframe

Validate i Create Exkernal Data Unit Tesk..,

RuUR As » | Hgm Create Sequence Unit Test...

Debug As i’ [igh Create Test Suite...

Profile &s 4

Team 4

Compare With ¥

Replace With 4

MATSEyle 4

JP4A Tools 4

Properties

3 Select the environment in which you want to run the test.
The results of the test are displayed in the Natural Unit Test view.

J Note: The list of environments is defined in the Preferences window for RPC environ-

ments. For information on adding additional environments to the list, see Define Addi-
tional RPC Environments.

Test for an Expected Error

To allow a test to pass with an expected error, define information about the error in the Error
section of the Summary tab. For example:
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* Error

|:| Expect errar
Error class:
Error code:

Message: D Regex

Summary | Inpuk | Yalidation | Connection

This will allow a test to fail only if it encounters an unexpected error.

» To test for an expected error:

1  Select Expect error.

2 Type the error class in Error class.

For Natural errors, the error class is 1014.

3  Type the error code in Error code.

You can also use the Error section to search the message text for a specific string.

» To search the message text for a specified string:

1 Type the string in Message.
2 Select Regex.

If you specify ".* division by zero.*", for example, Regex will search for "division by zero"
anywhere in the error message.

Test an Array Field

You can expand or reduce an X-array using the Resize Array property. For example:

= E1-50ME-PARMS Property Value
UNI-FIELD -= = Array
ROWS[] Preserve data  true
Resize Array 20
= Misc
MName ROWS[

For some arrays, all values are displayed. For example:
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E1-SOME-PARMS
ROWS

Property Yalue
= Array

Preserve data true

Resize Array 10
= Misc

oL ROWS (A10/v10) InOut

MName ROWS
= value

Value (1)

Value (2)

Value (3)

Value (4)

Value (5)

Value (&)

Value (7)

Value (&)

Value ()

Value (10}

Create a Unit Test for a Subprogram

» To create a unit test for a subprogram:

1  Open the context menu for the Natural project containing the subprogram in the Navigator

view.

Or:

Open the context menu for the subprogram in the Navigator view.

2 Select Testing.

The test options for subprograms are displayed.

3  Select Create Unit Test.

The Define Natural Unit Test Details panel is displayed. For example:
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7= Mew Natural Unit Test

Define Natural Unit Test Details

Enter the settings For a new Matural unit test,

Target

- B)X]

Praject: | MewProject

| [Brnwse...]

Parent suite: |

Test name: | CALC

| (default)
|

(... /Testing-Suites/CALC. natkst)

Display generated fileds)

Tatural

Subprogran: | MewProjectMatural-LibrariesCS3DEMO]SRCICALC NS

| [Brnwse...]

Finish ] [ Cancel

Using this panel, you can:

Task

Procedure

Change the name of the project in which
to create the unit test.

Type the name of the Natural project in Project or select
Browse to display a window listing the existing projects
for selection.

Note: The project must currently exist.

Provide the name(s) of a subfolder(s) in
which to save the unit test. If the folder
does not currently exist, it will be created
for you.

Type the name of the folder in Parent suite or select Browse
to display a window listing the available folders for
selection.

By default, the unit test is stored in the Testing-Suites
folder in the current project. If you specify a suite folder
name, it becomes a subfolder in the Testing-Suites folder
and the unit test will be stored in that folder.

Change the default name for the unit test.

Type a new name in Test name. File names are saved with
the .bsrvtst extension.

Generate default unit tests for
object-maintenance functions and/or
object-browse keys defined for Natural
subprograms.

Select Generate default Construct tests. This option is
enabled when the unit test will be created for Velocity or
Construct-generated object-browse or object-maintenance
subprograms. For information, see Generate Default Unit
Tests.

Not display the generated files in the editor
view after generation.

Deselect Display generated file(s).
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Task Procedure
Change the location of the folder Type or select a new folder in Subprogram.
containing the subprogram file.

4  Select Finish.

The unit test is displayed in the Testing-Suites folder in the Navigator view. For example:

T Wavigator £ =8

— <‘===€> O
== MNewProject- >daef.hg.sag-7307 (1)
+ =5 setkings
#-[= Business-Services
+-[E& Matural-Libravies
== Testing-Suites

Wl .natural
W= .projeck

The test is also displayed in the editor view. For example:

3k CALC nakkst 53 =0
Summary Q, @
+ Matural
Project: MewPraject
Library: DEMOTEST

Subprogram:  CALC
+ Connection

Broker ID:  IBMZ2.HQ.5AG:4010
Server: RPCIMBSS3IDEVCALLNAT

* Input

+ Yalidation

* Error

[JExpect error

Error class:

Error code:

Message: [regex

Surmary | Connection | Input | Yalidation
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The Summary tab displays information about the test, such as the name of the project, library,
and subprogram. It also displays the default connection settings. To define another connection
in which to run the test, see Define Connections.

| Note: You can use this tab to define an expected error, which allows a test to pass when

the expected error occurs. You can also use the tab to search for specified text in an
error message. For information, see Test for an Expected Error.

Select the Input tab and define which input parameters are sent to the server.

For information, see Configure Input Parameters.

Select the Validation tab and define which values must be returned for a successful test.

For information, see Define Validations.

Run the test.
For information, see Run the Unit Test.

Note: You can create Ant scripts to run Natural unit tests (file extension .nattst). For inform-
ation, see Creating Ant Scripts to Run Unit Tests.

Generate Default Unit Tests

This section describes how to generate default unit tests for browse keys and maintenance functions
(for example, GET, NEXT, etc.) defined for Velocity or Construct-generated object-browse or object-
maintenance subprograms. If a business service uses both object-browse and object-maintenance
subprograms, default tests can be generated for both the browse keys and the maintenance func-
tions.

This section covers the following topics:

= Generate Tests for a Business Service
= Generate Tests for a Natural Subprogram

Generate Tests for a Business Service

» To generate default unit tests for a business service:

1

Select Testing > Create Unit Test from the context menu for the business service in the Nav-
igator view.

The Define Business Service Unit Test Details panel is displayed.

Select Generate default Construct tests.

For example:
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3

7= Mew Business Service Unit Test |:|®

Define Business Service Unit Test Details

Enter the settings for a new business service unit kest,

Target

o

- -

Project: | :\IewProject

|[Browse...]

Parent suite; |

| (default) [Browse... ]

Test name: | Zuskamer

(.. fTesting-Suites/Customer bsrvst)
Generate default Construct kests
Display generated file(s)

Eusiness service

Service file: | MewProject JBusiness-Services/DEMO/Custorner.wi, 1.1, bsry

|[Browse...]

Method: | BROWSE ~|

@

Mext >

I

Finish

] [ Cancel

B

Note: This option is only available when the business service uses one or more subpro-

grams that were generated by an Object-Browse and/or Object-Maint wizard (either

Velocity-based or Construct).

Select Next.

The Define Parameters for the Default Maintenance Tests panel is displayed. For example:

56

Application Testing



Using the Test Functions

V= Mew Business Service Unit Test

Define Parameters for the Default Maintenance Tests [
Select and configure parameters for the generated kests,
[ -
Parent suite Folder: ... Testing-Suites
Select which tests to generate:
Generake Function Unik Test Marne Populate Key
EXISTS Custamer_EXISTS_1
FORMER Customer_FORMER_1 [l
GET Custamer_GET_1
INITIALIZE Customer_INITIALIZE 1 [l
MEXT Custamer_MEXT 1 [l
STORE Customer _STORE_1
[Generate Al ] [Generate Mone
Praovide walues For key Fields:
Field Mame Yalue
CUSTOMER., CIUSTOMER-MUMBER (MS) 0
Moke: Some bests may Fail because the specified key field value{s) may nok exist,
W
@) [ < Back ” Mek = l I Finish ] [ Cancel l

- B

| Note: If the business service does not use any object-maintenance subprograms, the

Define Parameters for the Default Browse Tests is displayed.

This panel displays the functions defined for all object-maintenance subprograms used by
the business service, as well as the key fields. Using this panel, you can:

Task

Procedure

Limit the generation of one or more
default tests.

Deselect Generate for the unit test(s) you do not want to
have generated. To generate unit tests for all functions, select
Generate All.

Limit the generation of all default tests.

Select Generate None.

Change the default population of key
fields.

Select or deselect Populate Key for the default unit test(s).
When selected, the test for the corresponding function will
populate the key field with the value specified in Value.

Provide a value for a key field.

Select Value for the key field and type the value. For
example, you can provide a customer number for the
Customer number field.

Enter details for a date/time field (when
defining details for a date or time field).

See Define Date and Time Details.
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Default tests can be created for each function defined for the subprogram that does not require
an existing record to be on hold. These functions are:

® STORE

* GET

NEXT

FORMER

EXISTS

INITIALIZE

| Note: As the DELETE and UPDATE functions require an existing record to be held,
default tests are not generated for these functions.

Specity a key value in Value for each function.

The tests are designed with the assumption that this value exists (i.e., the test will pass when
the value exists). The following assumptions are also made:

Function |Assumption

STORE |Assumes the specified key value exists and expects an error from the subprogram saying
the value already exists.

FORMER | Assumes a key value is not entered and expects a message from the subprogram saying
the beginning of file condition has occurred.

NEXT  |Assumes that the end of file condition has not occurred and expects a message from the
subprogram saying the next record was retrieved successfully.

The key components are those listed in the object PDA for the object-maintenance subprogram
as elementary fields under STRUCTURE. For example, MCUSTN, an object-maintenance
subprogram used by the Customer business service (located in the SYSBIZDE library), uses
the MCUSTA PDA:

1 MCUSTA-1ID N 5 /* Object identifier

R 1 MCUSTA-ID /* REDEF. BEGIN : MCUSTA-I
2 STRUCTURE /* To allow MOVE BY NAME
3 CUSTOMER-NUMBER N 5

In this example, CUSTOMER-NUMBER will be used as the key.
Select Finish.

Unit tests are created for all available browse keys and any object-maintenance subprogram
functions selected on the Define Parameters for the Default Maintenance Tests panel.

Or:
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Select Next.

The Define Parameters for the Default Browse Tests panel is displayed. For example:

7= New Business Service Unit Test |;|@

Define Parameters for the Default Browse Tests =

Select and configure parameters For the generated tests,

Parent suite Folder: ... /Testing-Suites

Generate Key

MAME
MAME-BACKWARDS
MAME-WAREHOLUSE
CUSTOMER-NUMBER

CUSTOMER-NUMBER-BACKWARDS

FEEEE

[Generate all ] [Generate Mone

o

[N -]

Unit Test Mame

Customer-ByMAME
Customer-ByMAME-BACKWARDS
Customer-ByMAME-WAREHOUSE
Customer-ByCIISTOMER-NUMBER.
Custarner-ByCUSTOMER-NUMBER -BACKWARDS

Finish l[ Zancel ]

B

Note: If the business service does not use any object-browse subprograms, Next is not

available on the Define Parameters for the Default Maintenance Tests panel.

This panel displays the key fields defined for all object-browse subprograms used by the
business service. Using this panel, you can:

Task

Procedure

Limit the generation of one or more default
tests.

Deselect Generate for the unit test(s) you do not want to
have generated. To generate unit tests for all keys, select
Generate All

Change the name of a default unit test.

Type the new name for the unit test on the corresponding
line in Unit Test Name.

Limit the generation of all default tests.

Select Generate None.

Default tests can be created for each browse key defined for the subprogram. These tests include
default validations for items like rows returned and error codes. For a HISTOGRAM key, key

value totals can be verified.

Select Finish.

The default unit tests are displayed in the Testing-Suites folder in the Navigator view. For

example:
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TS Mawigator 2 == ¥ =0

== NewProject-=dasf.hq.sag-7307 (1)

+[= ,settings

+- = Business-Servicas

+-[E Matural-Libraries

== Testing-Suites

== Customer Tests

Ham Customner_EXISTS.bsrvist
s Customer_FORMER.bsrvtst
Hge Customner_GET bsevtst
s Customer _IMITIALIZE bsrvist
Hagm Customner_MEXT bsrvbst
Has Customer_STORE bsrwtst
He Customner-By CUSTOMER-NUMBER-BACKWARDS, bsrvist
s Customer-ByCUSTOMER-MUMBER  bsrvtst
Ham Customner-ByMAME-BACKWARDS, bsrvist
s Customer-ByMAME-WAREHOUSE, barvtst
Ham Customner-ByMAME.bsrvtst

The tests are also displayed in the editor view. For example:

1 Customer-ByNAME-BACK 1 Customer-ByhAME-WARE 1 Cuskomer-BywCLISTOMER- 3 Customer-By CUSTOMER- s i =0
Summary Q, @
~ Natural
Project: MewProject

Business service: DEMO, Customer.wl.1.1
Method: BROWSE

* Connection

Broker IDv localhosk: 1971

Server: RPC/MATIRYZE00/CALLMNAT

 Input

CDERPDA.SORT-KEY - CUSTOMER-NUMBER-BACK\WARDS
COERPDA, ROWS-REQUESTED - = 20

« Yalidation

CDBRPDA, ACTUAL-ROWS-RETURNED - 0 {Comparisonialidator)
MSE-INFO, ##RETURN-CODE -> (Comparisonialidator)
ACUSTP.PREV-REC -=> (Comparisonyalidator)

* Error

D Expect error
Error class:
Error code:

Message: [(Iregex

Summary | Connection | Input | Yalidation

Default input values and validations are created for each unit test. You can change the default
values by selecting the appropriate tab. For example, select the Input tab to change the input
values generated for the test:
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18 Custamer-By CUSTOMER-MUMBER-BACKMARDS bsrwtst 23

Input

Configure the input fields to be sent ko the server,

=0
Field Mame Index | Walue

{CDBRPDA. SORT-KEY CUSTOMERNU,.
COBRPDA. ROMWS-REQLUESTED 20

Add Array...

Summaty | Connection | Input | Yalidation

| Note: For more information, see Configure Input Parameters.

Select the Validation tab to change the validations generated for the test. For example:

jm Custamer-By CUSTOMER-MUMEBER-BACKM ARDS bsrvtst 25

Validation

Configure Fields to be tested after the call bo the server is made.,

=0
Field Mame Index = Value Yalidatar

{CDBRPDA. ACTUAL-ROWS-RETURMNED 1] Comparisonyali,..
MSG-INFO, # #RETURN-CODE Comparisonvali. ..
ACUSTP.PREY-RED) Comparisonyali...

Add Array...

Summary | Connection | Input | Yalidation

) Notes:

1. For more information, see Define Validations.

2. You can create Ant scripts to run unit tests (file extension .bsrvtst, .exttst, .nattst, and .seqtst).
For information, see Creating Ant Scripts to Run Unit Tests.
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Generate Tests for a Natural Subprogram

» To generate default unit tests for a Natural subprogram:

1  Select Testing > Create Unit Test from the context menu for the subprogram in the Navigator

view.

The Define Natural Unit Test Details panel is displayed.

2 Select Generate default Construct tests.
For example:
72 Mew Matural Unit Test |Z|E]
Define Natural Unit Test Details =
Enter the settings for a new Matural unit test,
[ d
Targek
Project: | MewProject | [Browse... ]
Parent suite: | |(deFauIt)
Test narne: | |
(... JTesting-3uites)
Generate default Construct tests
Display generated fileds)
Matural
Subprogran: | MNewProject Matural-Libraries/DEMOTEST (SRCIMCUSTM. MSM | [Browse... ]
@:l [ Mek = l I Finish ] [ Cancel l
| Note: This option is only available when the subprogram was generated by an Object-
Browse or Object-Maint wizard (either Velocity-based or Construct).
3  Select Next.
If the subprogram was generated by an Object-Maint wizard, the Define Parameters for the
Default Maintenance Tests panel is displayed. For example:
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7= Mew Natural Unit Test

Select and configure parameters For the generated kests,

Define Parameters for the Default Maintenance Tests m

Parent suite Folder: ...JTesting-Suites
Select which tests bo generate:

Generate Function Unit Test Mame Populate Key
STORE MCUSTH_STORE_Z
GET MCUSTH_GET_2
MEXT MCUSTH_MEXT 2 |
FORMER, MCUSTH_FORMER_Z |
EXISTS MCUSTH_EXISTS_Z
IMITIALIZE MCUSTN_INITIALIZE_Z ]

[Generate Al ] [Generete Maone

Provide walues for key fields:

Field Name Walue
CIUSTOMER., CUSTOMER-MUMEBER (WS ]

Maoke: Some kests may Fail because the specified key Field valug(s) may nok exist,

@j [ Finish ] [ Cancel

This panel is similar to the Define Parameters for the Default Maintenance Tests panel for
a business service unit test. For a description of this panel, see Generate Tests for a Business
Service.

Or:

If the subprogram was generated by an Object-Browse wizard, the Define Parameters for
the Default Browse Tests is displayed. For example:
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7= Mew Natural Unit Test

Define Parameters for the Default Browse Tests

Select and configure parameters For the generated tests,

Parent suite Folder: ... /Testing-Suites

Generate Key
MAME
MAME-BACKWARDS
MAME-WAREHOLUSE
CUSTOMER-NUMBER
CUSTOMER-NUMBER-BACK WARDS

Unit Test Mame

ACISTH-ByMAME
ACSTH-ByMAME-BACKWARDS
ACISTH-ByMAME-WAREHOLUSE

ACSTN-By CUSTOMER-NUMBER

ACSTH-By CUSTOMER-NUMBER -BACK WARDS

[Generate all ] [Generate Mone

|

Finish ][ Zancel ]

This panel is similar to the Define Parameters for the Default Browse Tests panel for a
business service unit test. For a description of this panel, see Generate Tests for a Business

Service.

Select Finish.

The default unit tests are displayed in the Testing-Suites folder in the Navigator view. For

example:

U7 MNavigator 0 P = =
=-1=% NewProject-»daef.hg.s5ag-7307 (1)

= .setkings

[= Business-Services

(& Matural-Libraries

[=[= Testing-Suites

== Customer Tests
{4 ACUSTR-ByCLISTOMER-MUMBER_1.natkst

Hign ACUSTM-ByCUSTOMER-MUMBER-BACKWARDS _1.nattst

1k ACUSTH-EyINAME_1 natkst
Vi ACUSTH-EyNAME-BACKWARDS_1 .natkst
1R ACUSTH-EyNAME-WAREHOUSE 1 nattst

The tests are also displayed in the editor view. For example:
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g ACUSTN-ByMAME-WAREHO ik ACUSTN-EryCLISTOMER-MLU ik ACUSTH-ByCUSTOMER-MU 52~ 2 =0
Summary Q, @
« Natural
Prajeck: MewProject
Library: DEMOTEST

Subprogram:  ACUSTH
+ Connection

Broker ID:  IBMZ.HGQ. SAG:4010
Server: RPCIMBSSSDEY/CALLMAT

 Input

CDBRPDA, SORT-KEY - CUSTOMER-NUMEBER.-BACKWARDS
CDBRPDA, ROWS-REQUESTED - 20

« Yalidation

CDBRPDA, ACTUAL-ROWS-RETURMED - = O (Comparisontalidatar)
MSiE-INFC, # #RETURN-CODE - = {Comparisonyalidator)
ACJSTP.PREY-REQ -= (Comparisonvalidator)

* Error

|:| Expect errar
Error class:
Error code:

Message: D Regex

Summary | Conneckion | Input | Yalidation

This editor is similar to the editor for a business service unit test. For a description of the ed-
itor, see Generate Tests for a Business Service.

Create a New Unit Test Suite

This section describes how to create a new unit test suite to organize and store your Natural and
business service unit tests (file extension .bsrvtst, .exttst, .nattst, and .seqtst). The tests are generated
into the Testing-Suites folder or subfolder within a specified Natural project.

| Note: Ant scripts for Natural unit tests may contain unit test files existing outside of the
Testing-Suites folder or subfolder.

» To create a new unit test suite:

1  Select Testing > Create Test Suite for a project in the Navigator view.
Or:
Select Testing-Suites > Create Test Suite in the Navigator view.
Or:

Select Testing-Suites > SubfolderName > Create Test Suite in the Navigator view.
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The Define Test Suite Details panel is displayed. For example:

7= Mew Test Suite

Define Test Suite Details

Enter the target settings For a new test suite,

Targek

Project: f\lewPrnject
Parent suite: {default)

Suite name:

Q

Using this panel, you can:

Task Procedure
Change the name of the project in Type the name of the Natural project in Project or select Browse
which to create the test suite. to display a window listing the existing projects for selection.

Note: The project must currently exist.

Provide the name(s) of a subfolder(s) | Type the name of the folder in Parent suite or select Browse
in which to save the unit test. If the |to display a window listing the available folders for selection.
folder does not currently exist, it will

be created for you. By default, the unit test is stored in the Testing-Suites folder

in the current project. If you specify a suite folder name, it
becomes a subfolder in the Testing-Suites folder and the unit
test will be stored in that folder.

2 Type the name of the test suite in Suite name.

3  Select Finish.

The test suite is generated into the Testing-Suites folder or subfolder.
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Create Summary Reports for Unit Test Log Files

This section describes how to create unit test log files and then use the log files to create summary
reports. Log files can be created for any subprogram and business service unit test executed
within a NaturalONE project.

This section covers the following topics:

= Create Unit Test Log Files
= Generate a Summary Report

Create Unit Test Log Files

A unit test history log file can be created to save the results of a unit test whenever it is executed
(for example, the test name, test status, date/time completed, error messages, etc.). To create these
files, you must select the option in the Preferences window for Testing. For information, see Set

Logging Preferences for Unit Tests.

Generate a Summary Report

» To generate a report:
1 Select Testing > Create Unit Test Report for a project in the Navigator view.
Or:
Select Testing-History > Testing > Create Unit Test Report in the Navigator view.

The Define Report Details panel is displayed. For example:
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T2 New Unit Test Report |._|rE|E|
Define Report Details ke
Enter settings for the report parameters,
[ -

Project: |JERNnE=a

Dhate criteria

Skark date; | 12/23/2011 =
End date: | 12/23/2011 =

@j Finish l l Cancel

] Note: To change the name of the Natural project, type the name of the project in Project
or select Browse to display a window listing the existing projects for selection.
2 Type or select the name of the report in Report.

The report types are Detail, Daily summary, History chart and Weekly summary (see below
for an example of each report).

3  Select the range of dates for the report in Date criteria.

4  Select Finish.
The report types are:

Detail
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(i Unit Tesk Detailed Resulks 53 = B8

Unit Test Detailed Results
e 2
Showing page 1 of 1 4l 4 ¥ P Goto page:

Detailed Test Results By Day
(MewPraject: 01/012012 to 01/08/2012)

Test Hame User ID Pass Elapsed Error Message
Time (s)

January &, 2012

Caloulatar. bsrt st canpr true 4703

Row #1 conpr falze 2469 Exception: MNatural RPC Server returns: CALC 9999 NATOOZ2
Irvalid command, or Subprogram CALC does not exist in library.
ME=01,CALT 9999010

Row #2 conpr falze 0,109 Exception: Natural RPC Server returns: CALC 9933 NATOOS2
Invalid command, or Subprogram CALC does nat exist in library.,
ME=01,CALC 9999010

Row #3 conpr false 0.034 Exception: Natural RPC Server returns: CALC 9933 NATOOS2
Invalid command, or Subprogram CALC does not exist in library.,
ME=01,CALC 9999010

CALC nattst caonpr true 0.531

Row #1 caonpr falze 0.034 Exception: MNatural RPC Server returns: CALC 9939 NATOOS2
Irvalid command, or Subprogram CALC does not exist in library.
ME=01,CALC 2922010

Fo #2 canpr falze 0.109 Exception: Matural RPC Server returns: CALC 99959 MNATOOZ2
Invalid command, or Subprogram CALC does not exist in library.
ME=01,CALC 9999010

Total (Pass/Fail) 275

January 8, 2012

Calculatar.bsrtst conpr true 3.078

Row #1 conpr false 2,282 Exception: Natural RPC Server returns: CALC 9933 NATOOS2
Invalid command, or Subprogram CALC does not exist in library.,
ME=01,CALC 9999010

Flow #2 conpr falze 0.046 Exception: Natural RPC Server returns: CALC 2999 NATOOS2
Irvalid command, or Subprogram CALC does not exist in library.
ME=01,CALZ 9999010

Fow #3 caonpr falze 0.034 Exception: MNatural RPC Server returns: CALC 9939 NATOOS2
Irvalid command, or Subprogram CALC does not exist in library.
ME=01,CALZ 9999010

CALC.nattst conpr true 0.438

Row #1 conpr false 0.032 Exception: Natural RPC Server returns: CALC 9933 NATOOS2
Invalid command, or Subprogram CALC does not exist in library.,
ME=01,CALC 9999010

Flow #2 conpr falze 0.078 Exception: Natural RPC Server returns: CALC 2999 NATOOS2
Invalid command, or Subprogram CALC does not exist in library.
ME=01,CALC 9999010

Total (Pass/Fail) 275

Jan 8, 2012 9:50 AM

This report shows:

® Name project containing the tests, as well as the range of dates included in the report

= Name of each test
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User ID of the person who executed the unit test (or Unknown if the user ID cannot be determ-
ined)

Whether the test passed (true) or failed (false)

Elapsed time (in seconds) that the test took to run
® Error message for tests that failed
* Total number of tests that passed or failed

® Date and time the report was created

Daily Summary

(4 Daily Unit Test Summary Results &3

Daily Unit Test Summary Results
g s = S 2
Showing page 1 of 1

Daily Natural Unit Test Summary
(MewPraject: 01/01/2012 to 01/05/2012)

“l <4 ¥ ¥ Gotopage: ﬂ

Test Results

=3
‘1 %
2
‘ Passed
D .
o o — Failed
& &
Ly i3y
o -
z z
Date Pass Fail
Jan &, 2012 2 5
Jan @, 2012 2 5
Jan Total 4 10
Grand Total 4 10

Jan &, 2012 9:56 A

This report calculates and displays a daily Pass/Fail summary from every unit test executed

within a selected range of dates.

History Chart
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(3 Unit Test History Chart &3

Unit Test History Chart

i e B S F

Showing page 1 of 1

{4 P P Goto page: a

Natural Unit Test History

(MewPraject: 01/01/2012 to 01/03/2012)

Test Results

— Paszsed

~ Failed

=
-

Jan 5 2045
Jan 5 2015

Jan g, 2012 10:07 Al

=

Jan 8 2045

<

Jan 8 20 .

This report provides a graph of the Pass/Fail count for each Testing-History log file created

within a selected range of dates.

Weekly Summary
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(i Weekly Unit Test Summary Results 52

Weekly Unit Test Summary Results
SRR T
Showing page 1 of 1

Weekly Natural Unit Test Summary
(NewPraject; 010172012 to 01/08/2012)

4 4 ¥ ¥ Go to page: ﬂ

Test Results

.|
|
2
‘ Passed
o T/
o o — Failed
=~ &
— m'
o o
z =z
Date (Week starting) Pass Fail
Jan 1, 2012 2 g
Jan &, 2012 2 f
Jan Total 4 10
Grand Total 4 10

Jan 8, 2012 10:20 Aht

This report calculates and displays a weekly Pass/Fail summary from every unit test executed
within a selected range of dates.

Use the Dependencies View

When a generated module is open in the editor view, the Dependencies view displays dependencies
between business service and Natural unit tests and the business services and Natural subprograms
they execute. This section describes the nodes contributed to the view for these resources. The

following topics are covered:

= Business Service Unit Test Resources
= Natural Subprogram Unit Test Resources

) Notes:

1. Select \% to sort the resources alphabetically.

2. Select 4 to export a textual representation of the visible nodes in the view to a file.

3. When a supporting resource cannot be found locally using the project steplib chain and project
references, "<Unknown>" is displayed with the name of the resource. If the unknown module(s)
is not shipped with the Construct runtime project, either manually download it from the server

72 Application Testing



Using the Test Functions

or create it locally. If the module(s) is shipped with the Construct runtime project, add the
project. For information, see the Natural ONE Code Generation guide.

4. For more information about the Dependencies view, see the description of the source editor
in Using Natural ONE.

Business Service Unit Test Resources

When a business service unit test is open in the editor view, the root node displays the name of

the business service unit test. In caller mode (“®)), no child nodes are displayed because no other
Dependencies view objects depend on this business service unit test file. For example:

?—E Dependencies i3 o | Se| %[ ed T 8

= [y DEMO:Caloulator. vl 1.1
Hgm Calculator

In callee mode ( “=)), the child nodes display the name of the business service that the unit test ex-
ecutes, along with the names of the supporting business service resources and the names of the
libraries and projects in which they are located. For example:

?—E Dependencies &3 - =% laz ey T B

= [ DEMO:Calculator. vl 1.1
2. DEMO
+-§[F DEMOTEST:CALCY
fiFh DEMOTESTICALC

Natural Subprogram Unit Test Resources

When a Natural subprogram unit test is open in the editor view, the root node displays the name
of the unit test. In caller mode (=), no child nodes are displayed because no other Dependencies

view objects depend on a unit test file; in callee mode ( *m ), the child node displays the name of
the Natural subprogram that the unit test executes, along with the names of the supporting Nat-
ural resources and the names of the libraries and projects in which they are located. For example:

?—E Dependencies &3 o | 8z | %% ed T 8

= g ACUSTH
=
+ Eﬁ_ﬂ DEMOTEST: ACUSTH
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Create an External Data Unit Test

This section describes how to create a unit test that accepts input and/or validations from a CSV
file (file extension .csv). You can create a unit test once and then provide a data file containing
different input or validations to run iterations of the test. The wizard creates a unit test file that
accepts data from the CSV file.

This section covers the following topics:

= Create the Unit Test
= Configure Column Mappings and Sample Data

] Note: Similar to other unit tests, external data unit tests can be run from the unit test Ant

script. For information, see Creating Ant Scripts to Run Unit Tests.

Create the Unit Test

» To create an external data unit test:

1 Select Testing > Create External Data Unit Test for a project in the Navigator view.
Or:
Select Testing-Suites > Create External Data Unit Test in the Navigator view.
Or:

Select Testing-Suites> SubfolderName > Create External Data Unit Test in the Navigator
view.

The Define External Data Unit Test Details panel is displayed. For example:
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7= New External Data Unit Test |:|@@

Define External Data Unit Test Details

Enter the settings For a new external data unit test,

Target

Project: :\IewProject
Parent suite: | CalculatorTests

Test name:

Display generated files)

Source unit kesk details

() Create new test

(3) Use existing test

Source data file (C3%) details
() Create new file

() Use existing file

@)

-
Browse, ..

Brovse. ..

Browse. ..

Cancel

Using this panel, you can:

Task

Procedure

Change the name of the project in which
to create the external data unit test.

Type the name of the Natural project in Project or select
Browse to display a window listing the existing projects for
selection.

Note: The project must currently exist.

Provide the name(s) of a subfolder(s) in
which to save the external data unit test.
If the folder does not currently exist, it
will be created for you.

Type the name of the folder in Parent suite or select Browse
to display a window listing the available folders for selection.

By default, the unit test is stored in the Testing-Suites folder
in the current project. If you specify a suite folder name, it
becomes a subfolder in the Testing-Suites folder and the unit
test will be stored in that folder.

Type the name of the external data unit test in Test name.

Select an existing business service or Natural unit test in the Source unit test details section.

The selected unit test will be executed for each row in the data file. To display the available
unit test files for selection, select Browse for Use existing test. Optionally you can create a
new business service or Natural unit test. For information, see Create a New Unit Test.

Select an existing data file in the Source data file (CSV) details section.
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To display the available CSV data files for selection, select Browse for Use existing file. Op-
tionally you can create a new data file. For information, see Create a New Data File.

J

Note: A wizard is available to record the sample data used to test a business service or

subprogram directly and then export the data to a CSV file. For information, see Export

Test Data to a CSV File.

Select Finish.

The external data unit test file is generated into the Testing-Suites folder (or subfolder) and
listed in the Navigator view. For example:

T Wavigatar 3

=k

= 13' MNewProject-=daef.hq.5ag-7307

.

+
+
+
+
+
+
+

[= .settings

= .wsstack

= Business-3ervices

(= Construck

= dava

= b

(& Matural-Libraries

(== Testing-Histary

[ Testing-Suites

== ExternalSuite
Nas CALC.nattsk
E] calculatar.csy

i) —alculator, extkst
@. |User-Interface-Components
X .classpath
Wzl natural
W=l Jproject

The .exttst file is also displayed in the editor view.

J

Note: The .csv file and/or the .nattst/.bsrvtst files may also be created.

Define the configuration settings for the unit test in the editor view.

For information, see Configure Column Mappings and Sample Data.

Select the Connection tab and define the connection settings for the unit test.

For information, see Define Connections.

Save the settings.
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Create a New Unit Test

» To create a new unit test:

1 Select Create new test in the Source details section on the Define External Data Unit Test

Details panel.
2 Select Next.

The Define New Unit Test Details panel is displayed. For example:

7= New External Data Unit Test |Z|@@

Define New Unit Test Details

Enter the settings For a new unit test,

Test details

[ -

Mew best name: |

(... Testing-5uites/Externalsuite)
Source details

Object type: @ Subprograri O Business service

Object path: |

| [Browse ]

@

Cancel

3 Type the name of the unit test in New test name.

4  Select the object type for the source unit test in Object type.

You can select either Subprogram (the default) or Business service. When Business service

is selected, an additional field is added to the panel. For example:
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7= New External Data Unit Test |:|[E| g|

Define New Unit Test Details 5
Enter besk name m

|~ -

Test details
Mew tesk name:

(... Testing-5uites/Externalsuite)
Source details

Object type: O Subprogram @ Business service

Object path:
Object method: v
by

Select Browse in Object path.

A list of available business service or subprogram unit test files is displayed. Select the unit
test to use for the external data unit test and select OK.

For a business service unit test, select the method to test in Object method.

Select Finish to create the external data unit test and new unit test.
Or:
Select Next to create a new data file.

] Note: This option is only available when Create new file is selected on the Define Ex-
ternal Data Unit Test Details panel.

Create a New Data File

» To create a new data file:

1  Select Create new file in the Source data file (CSV) details section on the Define External
Data Unit Test Details panel.

2 Select Next.
The Define New Data File Details panel is displayed. For example:
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Define New Data File Details
Enter the settings for a new data File (C5Y),

Diata File (C5%) details
Mew data File name:
(... Testing-5uites/External Suite)
Row details
Delimiter: |,
[CIFirst rows conkains Field names

=]
=]

5

0

|~ -

Cancel

| Note: If Create new test on the Define External Data Unit Test Details panel is also
selected, the Define New Unit Test Details panel is displayed before this panel.

Using this panel, you can:

Type the name of the data file in New data file name.

Task

Procedure

Change the character used to separate
entries in the first row of the CSV file.

Type a new character in Delimiter.

Reserve the first row in the CSV file for
the field names.

Select First row contains field names. At runtime, the first
row in the CSV file is reserved for field names.

Note: When selecting fields for the first row in a CSV file, you

cannot specify the number of occurrences of an array to
include. By default, a maximum of five occurrences of each
array will be included. To add and/or remove occurrences
from the generated CSV file, you must edit the file manually.

Display fields that can be selected for
the first row of the CSV file.

Select Expand All To close the tree view, select Collapse All.

Select fields to be included in the first
row of the CSV file.

Select Select All and then deselect the fields you do not want
toinclude in the CSV file. To deselect all fields, select Deselect
AllL

test.

Select Finish to create the external data unit test, a new data file, and optionally, a new unit
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Configure Column Mappings and Sample Data

This section describes how to map columns in the CSV file (file extension .csv) to fields in the PDA
used by the business service or subprogram unit test. The following CSV file was used for examples:

FHFUNCTION, INPUT-DATA 4fFIRST-NUM, INPUT -DATA [SECOND-NUM, INPUT-DATA 4fSUCCESS-CRITERTA, QUTPUT -DATA AARESULT , QUTPUT-DATA.#/SUCCESS
Add,1,2,3,3,FALSE
Add,1,9,10,10,TRUE

» To configure column mappings and sample data:

1  Select the Configuration tab in the editor for the external data unit test.

For example:

i Calculator exttst £ =0
Configuration G E @
+ General

Inik tesk file: ExternalSuite/CALC . natkst
Daka file (C3%): | Externalsuite/calculabor, csy

Mote: File paths are relative to the Testing-Suites rook folder,
Firsk row contains field names

Colurin delimiter: |,

* Column Mappings

Calumn Field Marme Index Walidator Crikeria

INPUT-DATA, #FUNCTION
INPUT-DATA, #FIRST-MUM
INPUT-DATA, #5ECOND-MUM
INPUT-DATA, #5ICCESS-CRITERIA
OUTPUT-DATA, #RESLLT
OUTPUT-DATA, #3UCCESS

LUl ) I S W W

+ Sample Data

1 #FUNCTION 21 INPUT-DAT... 3 INPUT-DAT... 4 INPUT-DAT... 5 QUTPUT-DA... 6 QUTPUT-DA... Refrash

iAdd 1 2 4 4 FALSE
Add 1 9 10 10 TRUE

Zonfiguration | Conneckion
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2 Select Add in the Column Mappings section.

The Edit Mapping window is displayed. For example:

7= Edit Mapping g|
Edit Mapping i
Configure mapping entry settings m

= -
Column number: | il |
Field name: | ¥ |
Index: | |
Validatar: | ¥ |
Criteria:

@

The number of the first unmapped column is displayed in Column number. You can change
this number to define the mapping for another column.

3  Select the name of the field to use for this column in Field name.

4  Type the index position in Index (used when the field is an array).

5  Select the type of validator to use for the field in Validator.

The type of validator to use depends on the type of data in the field. The available validators
are:

BooleanValidator

ByteValidator

ComparisonValidator (displays a combo box with the options: ">", "<", "=", "<=", ">=")
DateValidator

DecimalValidator

IntegerValidator

RegexValidator (creates regular expressions to validate the contents of a field)
StringValidator

TimeValidator

6  Select OK.

The new column mapping is added to the list of mappings on the Configuration tab.

7  Continue adding column mappings until all columns used for the test have been added.
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* To revise a mapping, select the mapping in Column Mappings and select Edit. The Edit
Mapping window is displayed to change the mapping.

* To remove a mapping, select the mapping in Column Mappings and select Delete. The
mapping is removed from Column Mappings.

Optionally, you can use the Configuration tab to:

Task

Procedure

Change the name and/or location of
the unit test file used for the external
data unit test.

Type the name of the unit test in Unit test file or select Browse
to display a window listing the existing unit test files for selection.

Note: The unit test must currently exist.

Change the name and/or location of
the CSV file containing field names

and input for the external data unit

test.

Type the name of the CSV file in Data file or select Browse to
display a window listing the existing CSV files for selection.

Note: The CSV file must currently exist.

Reserve the first row in the CSV file
for the field names.

Select First row contains field names. At runtime, the first row
in the CSV file is reserved for field names.

Note: When selecting fields for the first row in a CSV file, you

cannot specify the number of occurrences of an array to include.
By default, a maximum of five occurrences of each array will be
included. To add and/or remove occurrences from the generated
CSYV file, you must edit the file manually.

Change the delimiter character used
to separate columns in the CSV file.

Type a new delimiter character in Column delimiter.

Retrieve sample data from the CSV
file.

Select Refresh in the Sample Data section. The first 20 rows in
the CSV file are retrieved.

Tip: To apply changes to the external data file to the unit test,
use this option with the Map option.

Map new sample data to the
columns.

Select Map (enabled when the First row contains field names
option is selected). A confirmation window is displayed,
indicating that all current column mappings will be removed.
Select Yes to delete the old mappings and apply the new
mappings.

Save the configuration settings.
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Create a Sequence Unit Test

This section describes how to create a sequence unit test (file extension .seqtst), a type of unit test
that executes a sequence of test steps in a specified order. Each test step executes a business service
or Natural unit test and, optionally, copies data between steps, applies field overrides, defines
validation overrides. and/or applies method overrides (business service unit tests only). These
overrides do not physically change the existing unit test files; the values are only changed in
memory prior to execution of the files.

For example, a sequence test can have the following two steps:

1. Invoke a unit test for a Construct-generated object-maintenance subprogram and attempt to
retrieve (GET) a data record.

2. Re-invoke the same test, but apply a field override that attempts to update the record. In addition,
copy all data from Step 1 and pre-configure each input field.

There are several methods you can use to create a sequence unit test, depending on your require-
ments. These methods include:

® Create one generic business service or Natural unit test and then create a sequence unit test
containing several test steps that reference the same generic unit test, but use a different field
override.

For example, you can create a generic Natural unit test called WAREHOUSE .nattst and then
create a unit test that reference a sequence of unit tests to override the value of WARE-
HOUSE.#FUNCTION, such as WAREHOUSE_GET.nattst, WAREHOUSE_NEXT.nattst, etc.

® Create several business service and/or Natural unit tests that reference the same subprogram/PDA

and then create a sequence unit test that references each unit test in a specified sequence.

For example, you can create a unit test for each warehouse function, such as WARE-
HOUSE_GET.nattst, WAREHOUSE_NEXT.nattst, etc., and then create a unit test that invokes
these tests in a specified sequence.

® Create several business service and/or Natural unit tests that reference different subpro-
grams/PDAs and then create a sequence unit test that references each unit test in a specified
sequence and copies data from one test to the next.

® Create a sequence unit test and one or more unit tests to use for the test.
This section covers the following topics:

= Create the Unit Test
= Use the Sequence Unit Test Editor
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= Use the Dependencies View

Create the Unit Test

This section describes how to use the wizard to create a sequence unit test.

» To create a sequence unit test:

1 Open the context menu for one of the following items in the Navigator view:

® Project folder

* Testing-Suites folder or subfolder

® One or more business service and/or Natural unit test files (using standard selection tech-
niques). The tests can reference the same subprogram/PDA or different subprograms/PDAs.
The wizard will create one test step in the generated sequence unit test for each unit test

selected in the Navigator view.

2 Select Testing > Create Sequence Unit Test.

The Define Sequence Unit Test Details panel is displayed. For example:

7= New Sequence Unit Test

Define Sequence Unit Test Details

Enter the settings For a new sequence unit est,

Target

Project: MewProject
Parent suite:

Test name:;

Display generated file(s)

o

= -

o

Cancel

- BX

3  Type the name of the sequence unit test in Test name.

Optionally, you can:
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Task

Procedure

Change the name of the project in which
to create the sequence unit test.

Type the name of the Natural project in Project or select
Browse to display a window listing the existing projects for
selection.

Note: The project must currently exist.

Provide the name(s) of a subfolder(s) in
which to save the sequence unit test. If
the folder does not currently exist, it will
be generated for you.

Type the name of the folder in Parent suite or select Browse
to display a window listing the available folders for selection.

By default, the unit test is stored in the Testing-Suites folder
in the current project. If you specify a suite folder name, it
becomes a subfolder in the Testing-Suites folder and the unit
test will be stored in that folder.

Select Finish.

The sequence unit test file is generated into the Testing-Suites folder (or subfolder) and listed

in the Navigator view. For example:

T Mavigator 3 =0
=
=i
B g MewProject- »daef hq.sag-7307

#-[= settings
H-[= wsstack
+-[= Business-Services
+-[= Construct
#-l=- Java
+- (B Matural-Libraries
+)-[= Testing-Histary
== Testing-Suites
#-[= CaleulakorTests
=[= Customer Tests
[Z3=] Customerpdate, segtsk

The .seqtst file is also displayed in the editor view. For example:

|F4 Customerlpdate, seqtst &3

Configuration

Test Steps
Define test steps and optional overrides,

Test Step Details
Set the properties For the selected step or override.

Configuration | Connection
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If one unit test file was selected in the Navigator view, a default test step is created for that
file. For example:

Customerllpdate. seqtst 0 =0
Configuration QE®
Test Steps Test Step Details
Define test steps and optional overrides, Set the properties for the selected step or override,
Mame: Step_1
Description:
Unit test file: | customer TestsMCUSTN. nattst | [ Browse. .. ]
TMew

Copy data

Configuration | Connection

If several unit test files were selected in the Navigator view, one test step is created for each
test. For example:

CustomerMaint.seqtst &3 - =
Configuration GE®
Teskt Steps

Test Step Details

Define test steps and optional overrides, Set the properties For the selected skep or override.

M crer er EWISTS. hs

Eag Skep_2 (Customer_GET bsrvist) .
- = Description:

Eag Skep_3 (Customer_IMITIALIZE, bsrvtst) P

Eag Step_4 (Customer-ByCUSTOMER-NUMEER-BACK WARDS, bsrwtsk)

EEg Skep_5 (Customer-ByCUSTOMER-NUMBER. bisrvtst)

Eag Step_6 {Customer-ByMNAME-BACKWARDS, bsrvisk) Unit test file: Customer_EXISTS, bsrytst
Eag Skep_7 (Customer-ByNAME-WAREHOUSE bsrvtst)

Add Mame: Step_1

|[ Browse, .. ]

Mew. ..

Copy data

Configuration | Connection
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Use the Sequence Unit Test Editor
This section describes how to use the sequence unit test editor. The following topics are covered:

= Add Test Steps

= Copy Data from a Previous Step
= Add an Input Override

= Add a Validation Override

= Add a Method Override

) Notes:

1. For information about the Connections tab, see Define Connections.

2. For general information about using the test editors, see Features of the Test Editors

Add Test Steps

This section describes how to add test steps to execute business service and/or Natural unit tests
in a specified order. Each test step executes one existing unit test and, optionally, copies data
between steps, applies field overrides, and/or defines validation overrides. In the following example,
the sequence unit test is generated from the context menu for a project and no steps are created.
For example:

Customerlpdate seqtst &3 =a
Configuration QE @
Test Steps Test Step Details
Define test steps and optional overrides, Set the properties for the selected step or override.

Configuration | Connection

] Note: To resize the editor sections, select the sash and move it left or right.

» To add test steps:

1 Select Add.

The Test Step Details section is displayed. For example:
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|4 *CustomerUpdate, segtst &2

@ Configuration Test step 'Step_1": Unit test file path is empty.

Tesk Steps

Test Step Details
Define test steps and optional overrides,

Set the properties For the selected skep or override.

Diescription:

Uit test file:
Mew, ..
Copy data

Configuration | Connection

2  Select Browse for Unit test file.

The Select Unit Test window is displayed. Select the unit test file and OK. The unit test details

are displayed in the Test Steps section and the selected unit test file is displayed in Unit test
file. For example:

|4 *CustomerUpdate. segtst &2

Configuration QE @
Test Steps

Test Step Details
Define test steps and optional overrides,

Set the properties for the selected step or override,

[Eim Step_1 (Customer_GET.bsrvbst) Name: S
Description:

Unit test file: | customer_GET,bsrvtst

| Browse... |

Copy data

Configuration | Connection

Or:
Select New for Unit test file.

The Select Unit Test Type panel is displayed. For example:
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7= News Unit Tast |-_| E| Fz|
Select Unit Test Type —
Select the bype of unit kest to create.
[ -
E.g Business Service Unit Test

Ham Matural Unit Test

\
@

Select one of the following options:
* Business Service Unit Test

The Define Business Service Unit Test Details panel is displayed. For information, see
Create a Unit Test for a Business Service.

® Natural Unit Test

The Define Natural Unit Test Details panel is displayed. For information, see Create a
Unit Test for a Subprogram.

] Note: When accessing these panels from the sequence unit test editor, the project name

defaults to the name of the project containing the sequence unit test and is read-only.
The unit test file specified for each test step must contain a relative path to the Testing-
Suites folder in the project containing the sequence unit test.

After defining the unit test and selecting Finish, the unit test details are displayed in the Test
Steps section and the newly created unit test file is displayed in Unit test file.

3  Select Add.

The second test step is displayed in Test Steps and the Copy data section is enabled. For ex-
ample:
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4 *CustomerUpdate, seqkst &2

Configuration

Tesk Steps
Define test steps and optional overrides,

EEg Step_1 (Customer_GET.bsrvkst)
stomer_GET.bstvtst)

Configuration | Connection

=0
Test Step Details
Set the properties for the selected step or override.
Mare: Step_2
Description:
Unit test file: | customer_GET,bsrvtst

Mew, ..

Copy data

[ Copy the data fram a previous step

Select or create the unit test for the second test step.

Repeat steps 1 and 2 until all test steps have been added. Optionally, you can use this editor

to:

Task

Procedure

Provide a description of this test step.

Type a description of the test step in Description
(maximum of 250 characters). The first 60 characters
are displayed as the tool tip for the test step in Test
Steps.

Copy data from a previous step.

See Copy Data from a Previous Step.

Delete a test step.

Select the test step in Test Steps and select Remove or
open the context menu for the test step and select
Delete.

Reorder the test steps.

Select the test step in Test Steps and select Up or Down.

Provide a name for the test step.

Type the step name in Name.

Define an input override for a field used in a
test step.

See Add an Input Override.

Define a validation override for a field used
in a test step.

See Add a Validation Override.

Define a method override for a method used
in a test step (business service unit tests only).

See Add a Method Override.

Save the settings.
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Copy Data from a Previous Step

This section describes how to copy data from a previous test step. When the generated sequence
test is run, the test step will attempt to copy the data from the specified test step. If the test steps
share the same Natural unit test file, the entire data structure from the previous test step is copied.
If the test steps use different Natural unit test files, each field is copied by name and the level 1
name (if present) is compared to the field name.

@ Caution: All values are copied, even when the Natural formats are different. This may result

in conversion errors (for example, when alpha values are placed in numeric fields).

» To copy data from a previous test step:

1  Select the test step to which you want to copy the data.
2 Select Copy data from a previous step.

3 Select the test step from which you want to copy the data in Step name.

You can select any previous test step in the list. Only previous test steps are listed, as data
cannot be copied from a test step that has not been run.

Note: When defining input or validation overrides, you can also select the field from
which to copy the data.

Add an Input Override

This section describes how to add an input override for a field. This value will override any input
value defined for an input field with the same name in the original unit test file. For example, if
the original unit test file has an input field and value of FUNCTION=GET and you add an override
to a test step that sets FUNCTION=UPDATE, then FUNCTION=UPDATE will be used.

» To add an input override:

1 Open the context menu for the test step in Test Steps.
2 Select New > Input Override.

The field details are displayed in Test Step Details. For example:
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*Customerlpdate seqkst &3 =0
Configuration G E @
Tesk Steps Test Step Details
Define test steps and optional overrides, Set the properties for the selected step or override,

Field name: | CUSTOMER., CUSTOMER-MUMBER. L

Yalue:

Copy data

Configuration | Connection

3  Type the override value in Value.

The input override is displayed in Test Steps. For example:

*Customerlipdate. seqtst &2 =
Configuration QE®@
Test Steps Test Step Details
Define test steps and optional overrides, Sek the properties for the selected step or override,

=) (Bl Step_t (Customer TestsjMCUSTN_GET.nattst) Field name: | CUSTOMER..CISTOMER-MUMBER v
B CUSTOMER CUSTOMER-NUMBER ('111)

[Egw step_2 (Customer Tests/MCUSTH_NEXT nattst) Index:

Yalue: 111

Copy data

Configuration | Connection

In this example, an override value for the CUSTOMER-NUMBER field has been added.

] Notes:

1. For information about the input parameters, see Configure Input Parameters.

2. You can copy the field data from a previous step. For information, see Copy Data from a
Previous Step.

3. To remove an input override, either select the override in Test Steps and select Remove
or open the context menu for the override and select Delete.
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Add a Validation Override

This section describes how to add an override value for a field validation. This value will override
any validation defined for an input field with the same name in the original unit test file. For ex-
ample, if the original unit test file has a field validation of #MSG <> ERROR and you add a validation
override of #fMSG <> WARNING, then both validations will be used (i.e., the wizard will ensure that
the message is not equal to both ERROR and WARNING).

» To add a validation override:

1 Open the context menu for the test step in Test Steps.
2 Select New > Validation Override.

The validation details are displayed in Test Step Details. For example:

|4 *CustomerUpdate.seqtst &3 =08
Configuration Q=@
Test Steps Test Step Details
Define test steps and optional overrides. Sek the properties for the selected step or override.
=I-[Ely Step_t (Customer Tests/MCUSTH_GET.nattst) Field name: | CUSTOMER..CISTOMER-MUMBER v
T T
18] CUSTOMER . CUSTOMER-MUMBER ('111%)
Vol CLISTOMER , CUSTOMER -NUMBER. (") Index:
Eﬂg Skep_Z {Customer TestsMCUSTM_MNEXT .nattst) validator: | Stringvalidator v

Yalue:

Configuration | Connection

3  Select the field name in Field name.

4  Select the override value in Validator.

The validation override is displayed in Test Steps. For example:
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Eﬂ *Customerlpdate seqtst £

Configuration

Test Steps

Test Step Details
Define test steps and aptional overrides.

Set the properties for the selected step or override.
= EE! Step_1 {Customer Tesks/MCUSTH_GET.nattst)
¥ CUSTOMER. CUSTOMER-MUMBER ('111%

18 CLSTOMER.CLISTOMER-TIMESTAMP (May 11, 2012 06:11:33.900 PM) Index:
Eb Step_2 {Customer Tesks/MCUSTM_MEXT.natkst)

Field name: | CUSTOMER, CLUSTOMER-TIMESTAMP -

‘alidator: imeYalidator
Date: siijzolz
Value: Time: Gi11:33PM 3

Fraction: | 9

Corfiguration | Connection

In this example, an override validation for the CUSTOMER-TIMESTAMP field has been added.

] Notes:

1. For information about the validation parameters, see Define Validations.

2. You can copy the validation data from a previous step. For information, see Copy Data
from a Previous Step.

3. To remove a validation override, either select the override and select Remove or open the
context menu for the override and select Delete.

Add a Method Override

This section describes how to add a method override value for a business service unit test. This
value will override the method name in the original business service unit test. For example, if the
original unit test has a method value of "BROWSE" and you add a method override value "EXISTS"
to a test step, then the sequence unit test will execute the "EXISTS" method.

» To add a method override:

1 Open the context menu for the test step in Test Steps.
2 Select New > Method Override.

The method details are displayed in Test Step Details. For example:
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[ *CustomerMaintenance.seqtst 53

Configuration QE @

Tesk Steps Test Step Details
Define test steps and optional overrides. Set the properties For the selected step or override,

Eag Step_1 {(Customer TestsMCUSTM_EXISTS.nattst) Method: | BROMISE 2

EE! Step_2 {Customer TestsMCUSTN_GET.nattst)
EE! Step_3 {(Customer TestsMCUSTM_INITIALIZE. nattst)
= EE; Step_4 {(Customer-ByCUSTOMER-MUMBER-BACK W ARDS . bsrvtst)

EE! Step_6 {(Customer-ByNAME-BACKWARDS, bsrvtst)
Eﬂg Step_7 {(Customer-ByMNAME-WAREHOUSE bsrvtst)

Configuration | Connection

3  Type the override value in Method.

The method override is displayed in Test Steps. For example:

| *CustomerMaintenance. seqkst 52

Configuration GE®

Test Steps Test Step Details
Define test steps and optional overrides. Set the properties for the selected skep or owerride,

IELS Step_1 (Customer TestsMCUSTN_EXISTS.nattst) Method: |G
tgm Step_2 (Customer Tests/MCUSTMN_GET.natkst)
Eag Step_3 {(Customer TestsMCUSTM_INITIALIZE. nattst)
= Eag Step_4 {Customer-ByCUSTOMER-MUMBER-BACKWARDS, bsrvist)
¥ Method (EXISTS)
EE; Skep_5 {Customer-ByCUSTOMER-MUMEER., bsrvhst)

Eﬁg Step_6 (iCustomer-ByMAME-BACK\WARDS bisrvtst)
Eag Step_7 {Customer-ByMNAME-WAREHOUSE bsrvtst)

Configuration | Connection

In this example, an override value of METHOD=EXISTS has been added.

] Notes:

1. For information about business service methods, see Natural ONE Business Services.

2. To remove a method override, either select the override in Test Steps and select Remove
or open the context menu for the override and select Delete.
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Use the Dependencies View

When a generated module is open in the editor, the Dependencies view displays dependencies
between a sequence unit test and the unit tests executed for each test step. This section describes
the nodes contributed to the view for these resources. The following topics are covered:

= Sequence Unit Test Resources
= Business Service Unit Test Resources
= Natural Unit Test Resources

) Notes:

1. Select \%z to sort the resources alphabetically.
2. Select w4 to export a textual representation of the visible nodes in the view to a file.

3. When a supporting resource cannot be found locally using the project steplib chain and project
references, "<Unknown>" is displayed with the name of the resource. If the unknown module(s)
is not shipped with the Construct runtime project, either manually download it from the server
or create it locally. If the module(s) is shipped with the Construct runtime project, add the
project. For information, see the Natural ONE Code Generation guide.

4. For more information about the Dependencies view, see the description of the source editor
in Using Natural ONE.

Sequence Unit Test Resources

When a sequence unit test is open in the editor view, the root node displays the name of the se-

quence unit test. In caller mode ( “&)), no child nodes are displayed because no other Dependencies
view objects depend on this sequence unit test file. For example:

?—E Dependencies (3 S | ®am | laz ey = 8
[Ed iCustomer Tests:CustornerUpdate:

In callee mode (")), the child nodes display one business service or Natural unit test for each test
step in the sequence unit test. For example:
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?—E Dependencies &3 = | Sg|%|l% e T O

= g8 Customer Tests:CustomerUpdate
+ygm Custamer Tests:MCUSTH_INITIALIZE
g Custorner Tesks:MCUSTH_GET
N Customer TestsiMCUSTN_STORE
Him Custarner Tesks:MCUSTHN_MERT
N Custormer-ByCUSTOMER-NUMBER-BACKWARDS
N Customer Tests:MCUSTH_EXISTS
Ham ACUSTN-ByCUSTOMER-NUMEBER-BACKWARDS
N Customer TesksiMCUSTN

RN O A e R e e

Business Service Unit Test Resources

When a business service unit test is open in the editor view, the root node displays the name of

the unit test. In caller mode (&), one child node is displayed for each sequence unit test that in-
cludes this unit test in one of its test steps. For example:

?—E Dependencies i o | %z | Y=[l% ed m|

= jig ‘Customer-ByCLISTOMER-NUMEER-BACKWARDS
{Ex Customer Tests:CustomerMaintenance
{Ei@ Customer TestsiCustomerUpdate

In callee mode (")), the child node displays the name of the business service that the unit test ex-
ecutes, along with the names of the supporting Natural resources and the names of the libraries
and projects in which they are located. For example:

?—E Dependencies &3 = | %a | Y=[l% A 8

= | Customer-ByCLISTOMER-NUMEER-BACK WARDS
=I-[4) DEMO:Cuskomer.v1.1.1
#1- ) DEMOTEST:ACUSTN
#- .. DEMO
+-{H DEMOTEST:MCUSTY
#- i DEMOTEST:MCUSTH

Natural Unit Test Resources

When a Natural unit test is open in the editor view, the root node displays the name of the unit

test. In caller mode (=), one child node is displayed for each sequence unit test that includes this
unit test in one of its test steps. For example:
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?—E Dependencies &3 = S |Y%|l%ed T O
= gk iCustomer TestsiMCUSTN_EXISTS |
|Ei# Customer Tests:OrderUpdate
|Ex# Customer Tests: Customerlpdate
|Ei# Customer Tests:WarehouseUpdate

In callee mode (), the child node displays the name of the Natural subprogram that the unit
test executes, along with the names of the supporting Natural resources and the names of the lib-
raries and projects in which they are located. For example:

?—E Dependencies &3 = | Sg|%|l% e T O

=l Nigh iCustomer Tests:iMCUSTN_EXISTS |
=8 DEMOTEST:MCUSTH

2€ DEMOTEST:MCUSTA

2 DEMOTESTIMCUSTR

2E SYSTEM:CDAOBIZ {ConstructRuntime}
£ DEMOTEST:CDPDA-M {AjaxProject}
£ SYSTEM:NCST-CLSTOMER
£ s
g
5

WSTEM:MCST-WAREHCUSE

WO Y ON O

SYSTEMIMCST-INS-POLICY
0F SySTEM:MCST-ORDER-HEADER
L?J SYSTEM:CCESCAPE {ConstructRuntime}
L:.J SYSTEM:CCDBCALZ {ConstructRuntime}
+-Ms OBIECT-MAINT-SUEP

Test an External Subroutine

This section describes how to test an external subroutine. The tester can test the subroutine using
either a subprogram or a program that calls a subprogram. The following tables describes which

option to use:

External Subroutine Features

Test Using

No parameters and screen
Input/Output

Program (Natural for Ajax provides the screen Input/Output)

Parameters and no screen
Input/Output

Subprogram (then you can use the subprogram tester to create scripts
so the tests can be run again)

Note: If there are parameters and no screen Input/Output, it is easier

to test the routine as a subprogram because the subprogram tester
can handle the variety of parameters.

Regardless of which option you use, temporary Natural objects are created to perform the tests
and then deleted when the Natural for Ajax page or subprogram tester is closed.

| Note: If you intend to use the temporary subprograms to create a unit (batch) test for the

subroutine, save the files locally before closing the tester.
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This section covers the following topics:

= Access the Subroutine Tester
= Test with a Program
= Test with a Subprogram

Access the Subroutine Tester

» To access the subroutine tester:

1  Open the context menu for the subroutine in the Navigator view.

2 Select Testing.

The test options for external subroutines are displayed. For example:

T Mavigakor 53 =8
Eg HEB T

= ConstructRuntime-=natural-runtime (13
= '[é MewwProject- =daef.hq.sag-7307 (1)
= .metadata
= .naturalone
= .settings
=& Matural-Libraries
=& MYLIB
=@ s 2| Copy

Mew r
Open
Open With 4

3 Delete
Mave, .,
Rename...

£=g Impart. ..
7 Export. ..

£ Refresh

MaturalOrE r

Code Generation r L?, Test Subroutine with Subprogram

‘ﬁ Upload
%, Build Project

D Predict Description and Generation ¥

Validate

Run As
Debug As
Profile As
Team
Compare With
Replace with

* v v w w

Properties
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Test with a Program

» To test an external subroutine using a program:

1 Open the context menu for the subroutine in the Navigator view.

2 Select Testing > Test Subroutine with Program.

The subroutine is tested and the results are displayed in the Natural I/O view. For example:

O Natural /o 52 =0

Matural Web 10 Output

Hello ||_

[Style Sheet 4

Test with a Subprogram

» To test an external subroutine using a subprogram:

1 Open the context menu for the subroutine in the Navigator view.

2 Select Testing > Test Subroutine with Subprogram.

The tester creates a temporary subprogram file to test the subroutine. For example:

R TSOIS0AT 52 =8
Property Walue
= Misc
1oL #8 (A3 InOut
Mame #4
= Value
Yalue

Drata | Conneckion
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| Note: This editor functions in the same way as the editor used to test a subprogram.

For information on using this editor, see Features of the Test Editors and Test a Sub-
program Directly.

Test a Natural Map

This section describes how to test a Natural map in NaturalONE. The tester allows you to test a
map as you would on the server (i.e., pressing PF4 in the Map editor).

| Note: The map must be available locally. If the map is not available locally, download it

from the server.

» To test a Natural map:

1  Open the context menu for the map in the Navigator view.

2 Select Testing.

For example:
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T Mavigakor 53 =0
@ B A7

I MCGDANSG

5 ncLavmm sm

B8 mcLAYOUT NS

NCLRCMD.MSH | New y
Open

Open With ’

5| Copy

¥ Delete
Maorve, .,
Rename...

£y Impart. .
75 Export. .,

& | Refresh

MaturalOME L4

Code Generation L4

E] Predict Description and Generation 4

Walidate

Run As
Debug As
Profile As
Tearn
Compate With
Replace With

* rF v v v v

Convert Map
JP& Tools L4

Properties

3 Select Test Map.

The map is displayed in the editor view. For example:

102 Application Testing



Using the Test Functions

(3 Matural Ifo &3

Natural Web I/0 Output

HCMATH

Tode Bubsystem

Direct Command:

Ertcer-FFL---FFi---FF#---FF4---FF§---FFE---FF7---FF#- --FF9- - -FFL0- -PF11--FFli---

[St-,rle Sheet

In addition to testing the output of the map, you can also test all code within the map. For

example, you can enter "?" in an input field to display the available help information (if help
has been attached to the map).

You can also apply a style sheet to the map by selecting » in Style Sheet. For example:

Application Testing 103



Using the Test Functions

(@ Makural Ifo &3

Natural Web [/0 Output

HCHATHR
Tode Subsystem

Direct Command:

Enter-PFL---FF2 - --PF3- --PP4-- -FF§ - - -FF6 - - -FF7 - - -FP§- - -FF4---FFL0--FF11--FFLé- - -

Style Sheet

Weh [/O style sheet: natural.css

=
Apply

In this example, the natural.css style sheet has been used.

To change style sheets, select the file in Web 1/O style sheet and select Apply. The map is
redisplayed with the selected style sheet. For example:
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(@ Makural Ifo &3 =0

Natural Web [/0 Output

HCRRIEY

Direct Commamd:

3- - -PP4-- -FF§---FFE - - -PFY- - -PFfi- - -FF4---FF10 --FF11--FF12- - -

rstule Sheet b
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4 Setting Preferences for Application Testing

= Set Logging Preferences for UNIt TESES ......ovviviiiiiiie e 108
= Set Server Synchronization PreferenCes ...........ooioiiiiiiiiie e 109
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This section describes how to set preferences for the supplied test function. The following topics

are covered:

Set Logging Preferences for Unit Tests

» To set logging preferences:

1 Select Preferences on the Window menu.

The Preferences window is displayed.

2 Select Software AG > Natural > Testing.

The Preferences window for Testing is displayed. For example:

L
= Preferences |

| | | Testing =1

General ”~
Unit best preferences
At .

CentraSite |:| Log unik tesks
Daka Managemant Upload resource(s) when they are not in sync with server
Help (dalways (O Mever  (3) Prompt
InstallfUpdate
Java
Java EE
Jarva Persistence
JavaScripk
Plug-in Development
Report Design
Run/Debug
Setver
Software AG
Ajax Developer
Business Services
Zode Generation
Conskruct
Enkires
Matural
Predict Description and Generation
Request Document
UDDI Registries

[0 B B - - B B

=13

‘Weh Services Stack . ’RESWVB Defaults l ’ Apply

)

@j [ Ok l [ Cancel

]

3  Select Log unit tests.
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Unit test log files will be created automatically each time a unit test is executed. The log files
are stored in the Testing-History folder within the NaturalONE project in which the unit test
was executed and include a .tstlog file extension. For example:

T Mavigatar &3 =8

e

= Tg MNewProject-=daef.hq.5ag-7307
== .settings
H-[= wsstack
4= Business-Services
e

20111016 _163040717 . tstlog
20111016_163108624,tstlog
¥| .classpath
W=l natural
NZ . project

| Note: If this option is not selected, the log files will not be created.

4  Select OK to save the preferences.

Set Server Synchronization Preferences

When testing a subprogram, a message may be displayed indicating that a local resource has not
been uploaded to the server and synchronized with the server resource. You can set preferences
for this option in the Preferences window for Testing.

» To set server synchronization preferences:

1  Select Preferences on the Window menu.

The Preferences window is displayed.

2 Select Software AG > Natural > Testing.

The Preferences window for Testing is displayed.

3 Select one of the options listed in Upload resource(s) when they are not in sync with server.

These options are:
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Option |Description

Always|Resource(s) are always uploaded to the server when not in sync.

Never |Resource(s) are never uploaded to the server when not in sync.

Prompt|A window is displayed to select an option.

4  Select OK to save the preferences.
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= Set Up the Environment ......

= Generate the Ant Script and Command FileS ..........viiiiiiiiii e

= Define the testsuite Ant Task
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Creating Ant Scripts to Run Unit Tests

You can use the Ant script wizard to create xml-based Ant scripts to run unit test files (file extension
bsrvtst, .exttst, .nattst, and .seqtst), and then create a Junit test file to run the Ant scripts program-
matically from Java. The wizard generates the following files:

® build.xml (contains the Ant script)

* run.cmd (contains the DOS command file to run the script)
For information on creating unit test files, see:

® Create a Unit Test for a Business Service
® Create a Unit Test for a Subprogram
® Create an External Data Unit Test

® Create a Sequence Unit Test

Set Up the Environment

If you use an RPC environment connection ID, the ID must be setup before running the wizard.
For information, refer to the EntireX documentation.

Generate the Ant Script and Command Files

This section describes how to create the build.xml and run.cmd files.

» To create the Ant script:

1 Select New > Other on the File menu.

The Select a wizard panel is displayed.
2 Select Software AG > Testing > Natural Unit Test Ant Script.

For example:
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-
= Hew

Select a wizard

Wizards:

== Software AG

[= Business Services

[ Code Generation

[= Entirex

== Testing
ji# Business Service Unit Test
nm External Data Test
jm Matural Unit Test
ﬁ Matural Unit Test &nk Scripk
[ Test Suite

[ Web Services Stack

@ < Back. Finish

Zancel

3  Select Next.

The Ant information panel is displayed. For example:

T2 News Matural Unit Test &nt Script

Ant information

e
Enter in details to create an Ank script For Matural unit best(s)

[ -
Eclipse root: | E:fSoftwaredGE2 eclipse v36] | [Browse... ]
‘Warkspace root: | E:fwaorkspaces MaturalORNESZ | [Browse... ]
Oukput container: | | [Browse... ]

Broker connection ID: |Natural RPC Mainframe |

zenerate .cmd File:

©

Mext =

Finish

Zancel

Using this panel, you can:

Application Testing
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Task

Procedure

Change the location of the default root folder in Eclipse.

Select a new folder in Eclipse root.

Change the location of the default workspace folder.

Select a new folder in Workspace root.

Change the Broker connection ID.

Select a new ID in Broker connection ID.

Suppress the generation of the run.cmd file containing the | Deselect Generate .cmd file.

DOS command file that runs the script.

Type the name of the Natural project in Output container or select Browse to display a list

of available projects for selection.

Select Next.

The Item Selection panel is displayed. For example:

72 Mew Matural Unit Test fnt Script

Item Selection

Select ikems to generate

Filesek:

Sample business service:
Sample subprogram:

- B

o

[N -

Browse, .,

@

] [ Cancel

Using this panel, you can:

Task Procedure

Suppress the generation of a sample business service.|Deselect Sample business service.

Suppress the generation of a sample subprogram. Deselect Sample subprogram.

Select the location of the default fileset folder (the workspace root folder and the output con-

tainer folder) in Fileset.

Select Finish.

The generated build.xml and run.cmd files are displayed in the Navigator view. For example:

14
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T Mavigatar 3 =8
- QE’ 1E =
= '[é MewProjeck- >daef hg.sag-7307 (1)

[= .settings
W=l natural

WE project

The build.xml file is displayed in the editor view. For example:

%abmhxw £3 =8

<?xml wersion="1.0" encoding="UTF-3" 2> Ll
<project default="default” name="Natural Tnit Tests":>
<target name="init":>
<property name="broker.environmentID” wvalue="Natural REPC Mainframe" />
<property name="test.dir" walue="E:/Workspaces/NaturalCNESZ/NewProject™ />

</targets
<target depends="init" name="defsults
<!—— Change logtests to "true® if you want test history to he saved -->

<testsuite logtests="false" nawme="tests">
<connection EnvirommentMame="${broker.environmentID} " />
<!-- Pun all the avallable unit tests from a folder --»
<fileset dir="g§{cest.dir}"»
<include name="**/% hsrvtst” />
<include namwe="* %/ % exttst” S
<include namwe="**/*%. naccst” S
</filezet>
“<l-— Walidators (Z3ee Eclipse online help <! ! ITOPIC!!!> for further details
BooleanWalidator
ByteValidator
ateValidator
DecimalValidator
IntegerValidator
RegexWalidator
StringWalidator
TimeValidator
-
<!-- ZBample subprogram —->
<!-- This sample assuwes you have a DEMOTEST library containing s subprogram called CALC --»
ol-=
<subprogram project="NewProject™ library="DEMCOTEST" notae="CALCI":
<input fieldName="INFUT-DATA.#FUNCTICON" wvaluse="Add" />
<input fieldName="INFUT-DALTL.#FIRIT-NUM" valus="2" />
<input fieldName="INPUT-DATA.#SECOND-NUN" wvalue="1" /=
<validate fieldWame="OUTPUT-DATL.#RESULT" type="IntegerValidator™ wvalus="3" />

</ subprogrsm:
-z
“!—— Bample khusiness service ——3
<!-— This sample assuwmes you have & dowain called DEMO containing a Caloulator service —-»
al-= e

8  Refine the parameters for the testsuite Ant task as desired.
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Define the testsuite Ant Task

This section describes the parameters for the testsuite Ant task in the generated build.xml file. The
following topics are covered:

= Description
= Parameters
= Parameters Specified as Nested Elements

Description

Represents the set of Natural unit tests to be run.

It is assumed that all necessary resources to run the tests are contained within a Natural ONE
project. To run subprogram tests, a local copy of the subprogram file (.nsn file) must be in the
correct Natural Library folder. To run business service tests, the folder must contain the domain
file, steplib file associated with the domain, and all subprogram file(s) referenced by the business
service.

Each testsuite contains a connection node that defines how the tests will connect the Natural
server.

There are three ways to run Natural unit tests:

® Create the units tests in NaturalONE using one of the Unit test wizards and then add a fileset
subnode that will load the generated .bsrvtst, .exttst, or .nattst files

® Add a subprogram node to test a specific subprogram

® Add a businessService node to test a specific business service

Parameters

Attribute | Description Required

logtests | Value indicating whether to log and save test history to the Testing-History folder. Valid [No
values are "true" (save test history) or "false" (do not save test history). By default, this
option is false.

name |Name used by the testsuite for output information in the test logs and Ant build log.  |No
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Parameters Specified as Nested Elements

This section describes parameters that are specified as nested elements. The following topics are
covered:

= connection

= fileset

= subprogram

= pbusinessService
= input

= validate

connection

Defines the connection settings to use to communicate with the Natural server.

Parameters
Attribute Description Required
environmentName |Name of an EntireX RPC connection Either environmentName or brokerID
configured in Eclipse.
brokerID Broker ID for the connection. Either environmentName or brokerID
address Broker address (when a broker ID is Mandatory when brokerID is used
specified).
userID User ID for the connection. Mandatory when brokerID is used
password Password. No
logon Whether a Natural logon is required. Optional and only when brokerID is
used
fileset
Runs a set of unit test files.
Parameters
Attribute | Description Required
dir Name of the folder/project containing the unit test files. |Yes
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Parameters Specified as Nested Elements

Parameter Description

include name

run all business service unit tests in the specified folder/project.

Name of the unit test(s) to run. For example, include name="**/* bsrvtst" / will

subprogram

Runs a single test against a subprogram.

Parameters
Attribute | Description Required
project [Name of the Eclipse Natural project containing the subprogram. Yes
library |Natural library containing the subprogram. Yes
name |Name of the subprogram to execute, excluding the file extension (.NSN). |Yes
Parameters Specified as Nested Elements
Parameter | Description
input See input.
validate |See validate.
businessService
Runs a single test against a business service.
Parameters
Attribute | Description Required
project |Name of the Eclipse Natural project containing the business service. |Yes
domain [Name of the domain containing the business service. Yes
name |Name of the business service to run. Yes
version |Version of the business service to run. Yes
method |Name of the method to test. Yes
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Parameters Specified as Nested Elements

Parameter |Description

input See input.
validate |See validate.
input

Specifies the value for a field to be used for input.

Parameters
Attribute | Description Required
name |Fully qualified field name in the format: |Yes
[Tevel onel.[namel
value |Value to assign to the field. Yes
validate

Specifies the field to be validated when it is returned by the call to the server.

Parameters
Attribute | Description Required
name |Fully qualified field name in the format: Yes

[level one]

.[name]

type  |Type of validator to use (see the following table). | Yes
value |Value to assign to the field. Yes
Validators

Type Description

BooleanValidator Validates Boolean values. True values are: x, t, true, or 1.

ByteValidator Compares an array of bytes.

ComparisonValidator | Compares values based on mathematical expressions (for example, ">", "<", "=",
"<=”, H>=” .

DateValidator Compares dates. The value is in the format: MON DD, YYYY (where MON is
a 3-character abbreviation for a month name).

Application Testing

19



Creating Ant Scripts to Run Unit Tests

Type Description

DecimalValidator Compares decimal values.

IntegerValidator Compares integer values. Decimals will be truncated.

RegexValidator Verifies that the value in the field matches a regular expression.
StringValidator Compares the value in the field against a string.

TimeValidator Compares the value in the field against a time. Time is in the format: MMM d,

yyyy hh:mm:ss.SSS.

120
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